
Owner’s Manual
Mode d’emploi

CLP- 885
CLP- 875
CLP- 845
CLP-835
CLP-895GP
CLP-865GP

FR

EN

Merci d’avoir choisi ce piano numérique de Yamaha !
Cet instrument offre une qualité de son et une expressivité exceptionnelles pour votre plus grand plaisir.
Afin d’exploiter votre Clavinova au maximum de ses performances et de ses fonctions, lisez entièrement ce mode 
d’emploi et conservez-le afin de pouvoir le consulter ultérieurement.
Avant d’utiliser l’instrument, lisez attentivement la section « PRÉCAUTIONS D’USAGE » aux pages 4 et 5.
Pour plus d'informations sur l’assemblage de l’instrument, reportez-vous aux instructions figurant à la page 63.

Thank you for purchasing this Yamaha Digital Piano!
This instrument provides exceptionally high-quality sound and expressive control for your playing enjoyment. 
In order to make the most of your Clavinova’s performance potential and features, please read this Owner’s Manual 
thoroughly, and keep it in a safe place for later reference.
Before using the instrument, be sure to read “PRECAUTIONS” on pages 4−5.
For information on assembling the instrument, refer to the instructions on page 63.
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FCC INFORMATION (U.S.A.)
1. IMPORTANT NOTICE: DO NOT MODIFY THIS UNIT!

This product, when installed as indicated in the instructions contained in this manual, meets FCC requirements. 
Modifications not expressly approved by Yamaha may void your authority, granted by the FCC, to use the product.

2. IMPORTANT: When connecting this product to accessories and/or another product use only high quality shielded 
cables. Cable/s supplied with this product MUST be used. Follow all installation instructions. Failure to follow 
instructions could void your FCC authorization to use this product in the USA.

3. NOTE: This product has been tested and found to comply with the requirements listed in FCC Regulations, Part 15 
for Class “B” digital devices. Compliance with these requirements provides a reasonable level of assurance that 
your use of this product in a residential environment will not result in harmful interference with other electronic 
devices. This equipment generates/uses radio frequencies and, if not installed and used according to the 
instructions found in the users manual, may cause interference harmful to the operation of other electronic 
devices. Compliance with FCC regulations does not guarantee that interference will not occur in all installations. If 
this product is found to be the source of interference, which can be determined by turning the unit “OFF” and “ON”, 
please try to eliminate the problem by using one of the following measures:
- Relocate either this product or the device that is being affected by the interference.
- Utilize power outlets that are on different branch (circuit breaker or fuse) circuits or install AC line filter/s.
- In the case of radio or TV interference, relocate/reorient the antenna. If the antenna lead-in is 300 ohm ribbon 
lead, change the lead-in to co-axial type cable.

If these corrective measures do not produce satisfactory results, please contact the local retailer authorized to 
distribute this type of product. If you cannot locate the appropriate retailer, please contact Yamaha Corporation of 
America, 6600 Orangethorpe Avenue, Buena Park, CA 90620, U.S.A.

The above statements apply ONLY to those products distributed by Yamaha Corporation of America or its 
subsidiaries.

(529-M04 FCC class B YCA 02)

COMPLIANCE INFORMATION STATEMENT
(Supplier’s declaration of conformity procedure)

Responsible Party: Yamaha Corporation of America
Address: 6600 Orangethorpe Avenue, Buena Park, CA 90620, U.S.A.

Telephone: 714-522-9011
Type of Equipment: Digital Piano

Model Name: CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received, including interference that may cause undesired operation.

(529-M02 FCC sdoc YCA 02)
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The model number, serial number, power requirements, etc., may 
be found on or near the name plate, which is at the bottom of the 
unit. You should note this serial number in the space provided 
below and retain this manual as a permanent record of your 
purchase to aid identification in the event of theft.

Model No.

Serial No.

(1003-M06 plate bottom en 01)

Information for users on collection and disposal of old equipment:
This symbol on the products, packaging, and/or accompanying documents means that used 
electrical and electronic products should not be mixed with general household waste.
For proper treatment, recovery and recycling of old products, please take them to applicable 
collection points, in accordance with your national legislation.

By disposing of these products correctly, you will help to save valuable resources and prevent any 
potential negative effects on human health and the environment which could otherwise arise from 
inappropriate waste handling.

For more information about collection and recycling of old products, please contact your local 
municipality, your waste disposal service or the point of sale where you purchased the items. 

For business users in the European Union:
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information.

Information on Disposal in other Countries outside the European Union:
This symbol is only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal.

(58-M02 WEEE en 01)

The name plate is located 
on the bottom of the unit.
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PLEASE READ CAREFULLY 
BEFORE PROCEEDING
Especially in the case of children, a guardian should 
provide guidance on how to properly use and 
handle the product before actual use.
Please keep this manual in a safe and handy place 
for future reference.

 WARNING
Always follow the basic precautions listed below to 
avoid the possibility of serious injury or even death 
from electrical shock, short-circuiting, damages, fire 
or other hazards. These precautions include, but are 
not limited to, the following:

Power supply

• Do not place the power cord near heat sources such as 
heaters or radiators. Also, do not excessively bend or 
otherwise damage the cord, or place heavy objects on 
it. 

• Do not touch the product or the power plug during an 
electrical storm. 

• Use only the correct voltage specified for the product. 
The required voltage is printed on the name plate of the 
product. 

• Use only the supplied or the specified AC adaptor 
(pages 79, 82)/power cord. Do not use the AC adaptor/
power cord for other devices. 

• Check the power plug periodically and remove any dirt 
or dust which may have accumulated on it.

• Insert the power plug firmly all the way into the AC 
outlet. Using the product when it is not plugged in 
sufficiently can cause dust to accumulate on the plug, 
possibly resulting in fire or skin burns.

• When setting up the product, make sure that the AC 
outlet you are using is easily accessible. If some trouble 
or malfunction occurs, immediately turn off the power 
switch and disconnect the plug from the outlet. Even 
when the power switch is turned off, as long as the 
power cord is not unplugged from the wall AC outlet, the 
product will not be disconnected from the power source. 

• Do not connect the product to an electrical outlet using 
a multi-plug outlet extender. Doing so can result in 
lower sound quality, or possibly cause overheating in 
the outlet.

• When disconnecting the power plug, always hold the 
plug itself and not the cord. Pulling by the cord can 
damage it and cause electric shocks or a fire.

• If not using the product for long periods of time, be sure 
to pull the power plug from the AC outlet.

Do not disassemble

• This product contains no user-serviceable parts. Do not 
attempt to disassemble the internal parts or modify 
them in any way.

Water warning

• Do not expose the product to rain, use it near water or 
in damp or wet conditions, or place on it any containers 
(such as vases, bottles or glasses) containing liquids 
which might spill into any openings or places where 
water may drop. A liquid such as water getting into the 
product may cause a fire, electric shocks, or 
malfunctions. 

• Use the AC adaptor indoors only. Do not use in any wet 
environments. 

• Never insert or remove a power plug with wet hands. 

Fire warning

• Do not place any burning items or open flames near the 
product, since they may cause a fire. 

Wireless unit

• Radio waves from this product may affect electro-
medical devices, such as a heart pacemaker implant or 
defibrillator implant. 

- Do not use the product near medical devices or inside 
medical facilities. Radio waves from this product may 
affect electro-medical devices. 

- Do not use the product within 15 cm (6 in.) of persons 
with a heart pacemaker implant or a defibrillator 
implant. 

Connections

• Be sure to read the manual of the device to be 
connected, and follow the instructions. Failure to 
observe this may cause a fire, overheating, explosion, 
or malfunction. 

Using the bench (if included)

• Do not place the bench in an unstable position where it 
might accidentally fall over. 

• Do not play carelessly with or stand on the bench. 
Using it as a tool or stepladder or for any other purpose 
might result in accident or injury. 

• Only one person should sit on the bench at a time, in 
order to prevent the possibility of accident or injury. 

• If the bench screws become loose due to extensive 
long-term use, tighten them periodically using the 
specified tool in order to prevent the possibility of 
accident or injury. 

• Keep special watch over any small children so that they 
don’t fall off the rear of the bench. Since the bench does 
not have a backrest, unsupervised use may result in 
accident or injury. 

PRECAUTIONS
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If you notice any abnormality

• If any of the following problems occur, immediately turn 
off the power switch and disconnect the power plug 
from the outlet. 
Finally have the device inspected by Yamaha service 
personnel. 

- The power cord or plug becomes frayed or damaged.

- Unusual smells or smoke are emitted.

- Some object, or water has been dropped into the 
product.

- There is a sudden loss of sound during use of the 
product.

- Cracks or other visible damage appear on the 
product.

 CAUTION
Always follow the basic precautions listed below to 
avoid the possibility of physical injury to you or 
others, or damage to the product or other property. 
These precautions include, but are not limited to, the 
following:

Assembly

• Assemble the product in the proper sequence by 
following the assembly instructions in this manual. Also, 
make sure to tighten the screws regularly. Failure to do 
so might result in damage to the product or even injury.

Location

• Do not place the product in an unstable position or a 
location with excessive vibration, where it might 
accidentally fall over and cause injury. 

• Do not go near the product during an earthquake. 
Strong shaking during an earthquake could cause the 
product to move or tip over, resulting in damage to the 
product or its parts, and possibly causing injury. 

• (CLP-885, CLP-875, CLP-845, CLP-835) When 
transporting or moving the product, always use two or 
more people. Attempting to lift the product by yourself 
may result in injuries, such as back injuries, or cause 
the product to be dropped and broken, which could lead 
to other injuries.

• (CLP-895GP, CLP-865GP) Since this product is very 
heavy, make sure that a sufficient number of people are 
on hand to help, so you can lift and move it safely and 
easily. Attempting to lift or move the instrument by force 
may damage your back, result in other injury, or cause 
damage to the instrument itself.

• Before moving the product, remove all connected 
cables, to prevent damage to the cables or injury to 
anyone who might trip over them. 

Connections

• Before connecting the product to other devices, turn off 
the power for all devices. Before turning the power on or 
off for all devices, set all volume levels to minimum.

• Be sure to set the volumes of all devices at their 
minimum levels and gradually raise the volume controls 
while playing the product to set the desired listening 
level. 

Handling

• Do not insert your finger or hand in any gaps on the key 
cover or product. Also take care that the key cover does 
not pinch your finger. 

• Do not insert foreign materials such as metal or paper 
into any openings or gaps of the product. Failure to 
observe this may cause a fire, electric shocks, or 
malfunctions. 

• (CLP-885) Do not apply excessive force when closing 
the key cover. A key cover equipped with the SOFT-
CLOSE™ mechanism closes the cover slowly. Applying 
excessive force to the key cover when closing it could 
damage the SOFT-CLOSE™ mechanism, and possibly 
result in injury to your hands and fingers caught under 
the closing key cover. 

• Do not rest your weight on, or place heavy objects on 
the product, and do not use excessive force on the 
buttons, switches or connectors. 

• Keep small parts out of the reach of infants. Your 
children may accidentally swallow them. 

• Do not use the product or headphones for a long period 
of time at a high or uncomfortable volume level, since 
this can cause permanent hearing loss. If you 
experience any hearing loss or ringing in the ears, 
consult a physician. 

• Remove the power plug from the AC outlet before 
cleaning the unit. Failure to observe this may cause 
electric shocks. 

Using the bench (if included)

• For benches that can be adjusted, do not adjust the 
bench height while sitting on the bench, since this can 
cause excessive force applied to the adjustment 
mechanism, possibly resulting in damage to the 
mechanism or even injury. 

• Do not place your hand between moving parts. 
Otherwise, your hand could be pinched between the 
parts, possibly resulting in injury. 

Always turn the power off when the instrument is not in 
use. 
Even when the [ ] (Standby/On) switch is in standby 
status (power lamp is off), electricity is still flowing to the 
product at the minimum level.
When you are not using the product for a long time, make 
sure you unplug the power cord from the wall AC outlet.

(DMI-11)

Yamaha cannot be held responsible for damage 
caused by improper use or modifications to the 
product, or data that is lost or destroyed.
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NOTICE
To avoid the possibility of malfunction/damage to the 
product, damage to data, or damage to other property, 
follow the notices below.

 Handling
• Do not connect this product to a public Wi-Fi and/or 

Internet service directly. Only connect this product to 
the Internet through a router with strong password 
protections. Consult your router manufacturer for 
information on optimum security practices. 

• Do not use this product in the vicinity of a TV, radio, 
stereo equipment, mobile phone, or other electric 
devices. Otherwise, this product or the other device 
may generate noise. 

• When you use the product along with an app on your 
smart device, such as a smartphone or tablet, we 
recommend that you enable “Airplane Mode” on the 
device to avoid noise caused by communication. When 
wirelessly connecting a smart device with this product, 
make sure that the Wi-Fi or Bluetooth® setting on the 
device is turned on.

• Do not expose the product to excessive dust or 
vibrations, or extreme cold or heat (such as in direct 
sunlight, near a heater, or in a car during the day) to 
prevent the possibility of disfiguration, damage to the 
internal components or unstable operation. (Verified 
operating temperature range: 5° – 40°C, or 41° – 
104°F.)

• Do not place vinyl, plastic or rubber objects on the 
product, since this might discolor the product.

• In the case of a model with a polished finish, bumping 
the surface of the product with metal, porcelain, or 
other hard objects can cause the finish to crack or peel. 
Use caution.

 Maintenance
• When cleaning the product, use a soft and dry (or 

slightly damp) cloth. Do not use paint thinners, 
solvents, alcohol, cleaning fluids, or chemical-
impregnated wiping cloths.

• In the case of a model with a polished finish, gently 
remove dust and dirt with a soft cloth. Do not wipe too 
hard since small particles of dirt can scratch the 
instrument’s finish.

• During extreme changes in temperature or humidity, 
condensation may occur and water may collect on the 
surface of the product. If water is left, the wooden parts 
may absorb the water and be damaged. Make sure to 
wipe any water off immediately with a soft cloth.

 Saving data
• A recorded Song is lost when you turn off the power to 

the product without saving the data. This also occurs 
when the power is turned off by the Auto Power Off 
function (page 17). Save the data to the product, or to a 
USB flash drive (page 38). 

• Some of the setting data of this product are retained 
when the power is turned off. You can back up the 
settings to the USB flash drive as a backup file, as well 
as restore it to the product. For details, refer to the 
Reference Manual.

• The data saved to the product may be lost due to some 
failure, an operational mistake, etc. Save your 
important data onto a USB flash drive or an external 
device such as a computer. 

• Before using a USB flash drive, make sure to refer to 
page 49. To protect against data loss through USB 
flash drive damage, we recommend that you save your 
important data onto spare USB flash drive or an 
external device such as a computer as backup data.

 Using the USB [TO DEVICE] terminal
• Compatible USB devices for the USB [TO DEVICE] 

terminal of this product are a USB flash drive or a USB 
wireless LAN adaptor (UD-WL01; sold separately) only. 
Other USB devices such as a USB hub or smart device 
cannot be used. When connecting a USB device, make 
sure that the connector on the device is appropriate 
and that it is connected in the proper direction. Do not 
use an extension cable when connecting a USB device. 
For a list of the compatible USB devices, access the 
Yamaha website below: 
https://download.yamaha.com/

• The rating of the USB [TO DEVICE] terminal is a 
maximum of 5 V/500 mA. Do not connect USB devices 
having a rating above this, since this can cause 
damage to the instrument itself.

• Avoid connecting or disconnecting the USB device 
while executing playback/recording and file 
management operations (such as Save, Copy and 
Delete), or when accessing the USB device. Failure to 
observe this may result in “freezing” of the operation of 
the instrument or corruption of the USB device and the 
data.

https://download.yamaha.com/
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Information
 About copyrights
• The copyright of the “content”*1 installed in this product 

belongs to Yamaha Corporation or its copyright holder. 
Except as permitted by copyright laws and other 
relevant laws, such as copying for personal use, it is 
prohibited to “reproduce or divert”*2 without the 
permission of the copyright holder. When using the 
content, consult with a copyright expert. 
If you create music or perform with the contents 
through the original use of the product, and then record 
and distribute them, the permission of Yamaha 
Corporation is not required regardless of whether the 
distribution method is paid or free of charge.
*1: The word “content” includes a computer program, audio 

data, Accompaniment Style data, MIDI data, waveform 
data, voice recording data, music score, and score data, 
etc.

*2: The phrase “reproduce or divert” includes taking out the 
content itself in this product, or recording and distributing it 
without changes in a similar manner.

 About functions/data bundled with 
the product

• Some of the preset Songs have been edited for length 
or arrangement, and may not be exactly the same as 
the original.

• (CLP-885/CLP-895GP) This product is capable of using 
various types/formats of music data by optimizing them 
to the proper format music data for use with the device 
in advance.   As a result, this device may not play them 
back precisely as their producers or composers 
originally intended.

• The bitmap fonts used in this product have been 
provided by and are the property of Ricoh Co., Ltd.

 About open source software
• The firmware of this product contains open source 

software. For copyright information and terms of use for 
each open source software, access the Yamaha 
website below: 
Yamaha Downloads: https://download.yamaha.com/

 About this manual
• The illustrations and LCD screens as shown in this 

manual are for instructional purposes only.

• Windows is a registered trademark of Microsoft® 
Corporation in the United States and other countries.

• Wi-Fi is a registered trademark of Wi-Fi Alliance®.

• The Bluetooth® word mark and logos are registered 
trademarks owned by Bluetooth SIG, Inc. and any use 
of such marks by Yamaha Corporation is under license. 

• The company names and product names in this manual 
are the trademarks or registered trademarks of their 
respective companies.

 Tuning
• Unlike an acoustic piano, this instrument does not need 

to be tuned by an expert (although the pitch can be 
user-adjusted to match other instruments). This is 
because the pitch of digital instruments is always 
maintained perfectly. 

 About disposal
• When disposing of this product, please contact the 

appropriate local authorities.

 About Bluetooth®

Bluetooth is a technology for wireless communication 
between devices within an area of about 10 meters 
(33 ft.) employing the 2.4 GHz frequency band.

• Handling Bluetooth communications
- The 2.4 GHz band used by Bluetooth compatible 

devices is a radio band shared by many types of 
equipment. While Bluetooth compatible devices use a 
technology minimizing the influence of other 
components using the same radio band, such 
influence may reduce the speed or distance of 
communications and in some cases interrupt 
communications.

- The speed of signal transfer and the distance at which 
communication is possible differs according to the 
distance between the communicating devices, the 
presence of obstacles, radio wave conditions and the 
type of equipment.

- Yamaha does not guarantee all wireless connections 
between this unit and devices compatible with 
Bluetooth function.
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When moving and placing the instrument 
Move the instrument horizontally. Do not subject the 
instrument to excessive vibration or shock. Since it is very 
heavy, make sure that a sufficient number of people are on 
hand to help, so you can lift and move it safely and easily. 
After moving the instrument, make sure all screws are 
properly tightened and have not been loosened. 
If you move to another location, you can transport the 
instrument along with other belongings. You can move the 
unit as it is (assembled) or you can disassemble the unit 
down to the condition it was in when you first took it out of 
the box.

CAUTION
When moving the instrument, always hold the bottom of the main 
unit. Holding another portion of the instrument can result in it being 
damaged or causing personal injury.

NOTICE
Before moving the instrument, rotate the adjuster under the pedal 
until it separates from the floor surface. Failure to do so may 
damage the floor surface.

The CLP-885 and CLP-895GP are compatible with the following formats.

GM System Level 2
“GM (General MIDI)” is one of the most common Voice allocation formats. “GM System Level 2” is a standard 
specification that enhances the original “GM” and improves Song data compatibility. It provides for increased 
polyphony, greater Voice selection, expanded Voice parameters, and integrated effect processing.

XG
XG is a major enhancement of the GM System Level 1 format, and was developed by Yamaha specifically to provide 
more Voices and variations, as well as greater expressive control over Voices and effects, and to ensure compatibility 
of data well into the future.

GS
GS was developed by the Roland Corporation. In the same way as Yamaha XG, GS is a major enhancement of the 
GM specifically to provide more Voices and Drum kits and their variations, as well as greater expressive control over 
Voices and effects.

Do not hold here.

Hold here.

Presses against 
the floor

Lifts from 
the floor

NOTE
(CLP-885/CLP-875 only) Place the instrument away from the 
wall by at least 10 cm to optimize and enhance the sound 
effect.
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About the Manuals

This instrument has the following documents and instructional materials. 

Supplied with the instrument

• Owner’s Manual (this book)
Explains the basic operations and functions of this instrument. Please read this manual first.

Available on the website

• Reference Manual
Explains various settings and functions controlled from the Menu (page 51). Please read this manual after reading 
the Owner’s Manual.

• Data List
Contains MIDI-related information of the instrument, as well as lists of XG Voices and XG Drum Kits that can be 
selected on the CLP-885 and CLP-895GP.

• Smart Pianist User Guide
Explains how to set up and use the smart device app “Smart Pianist” (page 46) for controlling this instrument.

Included Accessories

 Owner’s Manual (this book)
 “50 Classical Music Masterpieces” (Music Book)
 Online Member Product Registration
 Bench*
 Power cord*, AC adaptor*

* May not be included depending on your area. Check with your Yamaha dealer. 

Rules for the notes

WARNING
Important information to avoid the possibility of serious injury or even death from electrical shock, 
short-circuiting, damages, fire or other hazards.

CAUTION
Important information to avoid the possibility of physical injury to you or others, or damage to the 
instrument or other property.

NOTICE Important information to avoid the possibility of malfunction/ damage to the product, damage to 
data, or damage to other property.

NOTE Helpful information and tips.

To obtain these manuals, access the website below:

Yamaha Downloads 
https://download.yamaha.com/

* Enter the model name for searching the desired manuals.

https://download.yamaha.com/
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What You Can Do with Your CLP

Variety of Voices to complement your music page 26

This instrument features piano sounds created with samples of Yamaha’s flagship CFX concert grand piano and the 
famed Vienna-made Bösendorfer grand piano. Along with these two gorgeous piano sounds, a variety of other 
Voices such as piano, organ and strings are provided—allowing you to select the instrument sound that best 
matches the music you want to play. You can also layer two Voices, or play different Voices in the right and left areas 
of the keyboard. 

* Bösendorfer is a subsidiary company of Yamaha.

Helpful practice aids with Song data page 30

A variety of well-known classic Songs and lesson Songs including “The Virtuoso Pianist” are pre-installed to the 
instrument, and help you to practice efficiently. You can simply enjoy listening to these Songs, or play back only the 
left-hand part (or right-hand part) and practice each part individually. The playback tempo or speed can be adjusted 
as you like, so you can start in a slow tempo at first and increase it as you master the piece. Compatible 
commercially available Songs can also be used on this instrument. 

Recording and playing back your performances page 37

The instrument lets you record your performance to internal memory or a USB flash drive. Listening back to your 
recordings helps immensely in improving your performance. This instrument also allows you to record multiple parts 
independently and save as one Song. This may also help you to practice; for example, record the right-hand part 
first and then record the left-hand while listening to the already recorded right-hand part. Songs recorded with this 
method can be played back with independent parts—an effective tool for children’s one-hand practice by 
independently recording the right- and left-hand parts of the parent’s performance.

Enjoy playing along with Rhythms page 29

A variety of rhythm patterns (drums and bass accompaniment) in various genres such as pop and jazz are provided, 
letting you enjoy playing the piano along with dynamic Rhythm playback. The accompaniment bass sound 
automatically changes based on your performance and make it dynamic and professional sounding.

Listen to music through the built-in speakers (Bluetooth Audio) page 43

By connecting a Bluetooth-equipped audio player such as smartphone via Bluetooth, you can listen to music played 
back on the connected audio player through this instrument’s speakers.

Get more fun out of your piano with Smart Pianist app page 46

By installing the Smart Pianist app to your smart device such as a smartphone or tablet, you can connect the 
instrument to the device and take more advantage of this instrument. The easy-to-understand display helps you to 
control the instrument while checking the status of the settings. You can play the instrument while viewing the music 
score on the device, and record your performances to the device, etc.
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Panel Controls and Terminals

 CLP-885/CLP-875/CLP-845/CLP-835 
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Key cover

Control panel

Music rest

Music braces

[P] (Standby/On) switch

[VOLUME] slider

Pedals

USB [TO DEVICE] 
terminal

[AUX IN] 
jack

USB [TO HOST] 
terminal

[PHONES] 
jacks

[PEDAL] connector

Control panel

Music rest

Lid

Music braces

Key cover

4, 5 and 6 are 
located here.

Pedals

 CLP-895GP/CLP-865GP

[P] (Standby/On) switch

[VOLUME] slider

USB [TO DEVICE] 
terminal

[AUX IN] 
jack

USB [TO HOST] 
terminal

[PHONES] 
jacks

AUX OUT 
[L/L+R][R] jacks

AUX OUT 
[L/L+R][R] jacks

(CLP-845/CLP-835) DC IN jack

(CLP-885/CLP-875) DC IN jack

[DC IN jack

[PEDAL] connector

* This illustration shows the CLP-885.

* This illustration shows the CLP-895GP.

Key cover
Music rest

Music 
braces
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1 [P] (Standby/On) switch (page 17)
For turning the power on or setting it to standby.

2 [VOLUME] slider (page 18)
For adjusting the overall volume.

3 Control Panel (page 20)
For controlling the instrument, using the various functions, and changing the settings.

4 Key cover (page 14)
For keeping the keyboard clean and protecting it from dust or dirt.

5 Music rest (page 15)
For holding music books, etc.

6 Music braces (page 15)
For securely holding the pages of music books on the music rest.

7 Pedals (page 19)
For using as a damper pedal (right), sostenuto pedal (center) or soft pedal (left). (These are default settings.)

8 USB [TO DEVICE] terminal (pages 47, 49)
For connecting a USB flash drive or the UD-WL01 USB wireless LAN adaptor (sold separately). Before using the 
USB [TO DEVICE] terminal, be sure to read “Using the USB [TO DEVICE] terminal” on page 6.

9 USB [TO HOST] terminal (pages 47, 48)
For connecting to a computer or smart device such as smartphone or tablet.

) [AUX IN] jack (page 45)
For connecting to an audio player and inputting sound from that device to this instrument.

! [PHONES] jack (×2) (page 18)
For connecting headphones.

@ AUX OUT [L/L+R][R] jacks (page 50)
For connecting to an audio device such as a speaker system and outputting sound from this instrument to that 
device.

# DC IN jack (page 16)
For connecting the power cord and the AC adaptor.

$ [PEDAL] connector (page 19)
For connecting the pedal cord of the pre-installed pedal or the separately sold FC35 pedal unit.

% Lid (page 15)
For changing the sound resonance like on an actual grand piano by opening or closing it.
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Starting Up

For information on assembling the instrument, refer to the instructions on page 63.

To protect the keyboard and the inside of the instrument from the dust or dirt, make sure to close the key cover when 
you are not using the instrument. 

CAUTION
• Hold the key cover with both hands when opening or closing it. Be careful to avoid catching fingers (yours or others, especially 

children’s) between the cover and the unit.
• Do not place anything (such as metal objects or pieces of paper) on top of the key cover. Small objects placed on the key cover 

may fall inside the unit when the cover is opened and may be nearly impossible to remove. Once inside, they could cause electric 
shock, short circuit, fire or other serious damage to the instrument.

 CLP-885 
To open the key cover, hold the hand grip with 
both hands, and then lift to open it. Once it’s 
open, fold down the top of the key cover.
To close the key cover, first fold back the music 
rest (page 15). Then, open the folded top of the 
key cover, and close the cover gently with both 
hands.

CAUTION
Do not apply excessive force when closing the key 
cover. Doing so can damage the SOFT-CLOSE™ 
mechanism, and possibly result in injury to your hands 
and fingers caught under the closing key cover.

 CLP-875/CLP-845/CLP-835/CLP-895GP/CLP-865GP 
To open the key cover, lift it slightly, and then 
push and slide it to the end. To close the key 
cover, slide it toward yourself and gently lower it. 

Opening/Closing the key cover

CAUTION
Be careful to avoid catching your fingers when opening 
or closing the cover.

CAUTION
Be careful to avoid catching your fingers when opening 
or closing the cover.
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 CLP-885 
To use the music rest, unfold it from under the 
inside of the key cover. The music braces can be 
raised to securely hold the pages of music books 
on the music rest.
To close the music rest, close the music braces 
first, and then fold back the music rest toward the 
key cover.

 CLP-875/CLP-845/CLP-835/CLP-895GP/CLP-865GP 
To use the music rest, pull it up toward yourself as 
far as it will go (1), and then flip down the two 
metal supports on the rear of the music rest (2). 
After that, lower the music rest so that the metal 
supports latch into place. The music braces can 
be raised to securely hold the pages of music 
books on the music rest. 
To close the music rest, pull it up toward yourself 
(1), and then raise the two metal supports (2). 
After that, gently lower the music rest backward 
until it is all the way down.

CAUTION
Do not try to use the music rest in a half-raised position. Also, when raising or lowering the music rest, do not release your hands 
from the music rest until it is all the way up or down. 

WARNING
• Do not let children open or close the lid. Also, be careful to avoid catching fingers (yours or others, and especially those of 

children) when raising or lowering the lid.
• Make sure that the end of the stay fits securely in the lid recess. If the stay is not properly seated in the recess, the lid may fall, 

causing damage or injury.
• Be careful that you or others do not bump the stay while the lid is raised. The stay may be dislodged from the lid recess causing 

the lid to fall.

To open the lid:

1 Raise and hold the right side of the lid 
(viewed from the keyboard end of the 
instrument).

2 Raise the lid stay and carefully lower the lid 
so that the end of the stay fits into the 
recess in the lid.

Using the music rest

Opening/Closing the Lid (CLP-895GP/CLP-865GP only)

Music braces

1

2

Music braces

1

2
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To close the lid:

1 Hold the lid stay and carefully raise the lid.

2 Hold the lid in its raised position and lower 
the lid stay.

3 Carefully lower the lid.

Connect the plugs of the AC adaptor and power cord in the order shown in the illustration. To confirm the location of 
the DC IN jack, refer to page 12.

WARNING
• Use the supplied or the specified AC adaptor (page 79 or page 82)/power cord only. Do not use the AC adaptor/power cord for 

other devices. Using the wrong AC adaptor/power cord can result in damage to the instrument or overheating. 
• When setting up the product, make sure that the AC outlet you are using is easily accessible. If some trouble or malfunction 

occurs, immediately turn the power off and disconnect the plug from the outlet.

NOTE
When disconnecting the power cord/AC adaptor, first turn off the power, and then follow this procedure in reverse order.

CLP-895GP only
For the longer stay, use the inner recess, and for the shorter stay, use the outer recess to support the lid.

WARNING
Do not use the outer recess for the longer stay. Doing so makes the lid unstable and may cause it to fall, resulting in damage 
or injury.

Power supply

Longer stay Shorter stay

1

3

2

1

2

3

DC IN jack 
(DC IN 24 V or DC IN 16 V)

DC plug

AC adaptor

Power cord AC plug

AC outlet

The shapes of the plug and 
outlet may differ depending on 
your locale.
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1. Turn down the [VOLUME] slider to “MIN.”

2. Press the [P] (Standby/On) switch to turn the power on.
The display located at the left of the keyboard and the power indicator on the [P] (Standby/On) switch both 
light up.

NOTICE
Press only the [P] (Standby/On) switch when turning the power on. Any other operations, such as pressing the keys, buttons 
or pedals may cause the instrument to malfunction.

3. After you finish using the instrument, turn off the power by pressing the [P] (Standby/
On) switch for a second.

CAUTION
Even when the [P] (Standby/On) switch is in standby status, electricity is still flowing to the instrument at the minimum level. 
Remove the electric plug from the outlet when the instrument is not to be used for extended periods of time, or during 
electrical storms.

Auto Power Off function

The Auto Power Off function automatically turns the power off if the instrument is not operated for a specified period 
of time (15 minutes by default). This prevents unnecessary power consumption. The amount of time that elapses 
before the power is automatically turned off can be changed from “Utility” > “Auto Power Off” in the System menu 
(page 51). For details, refer to the Reference Manual.

NOTICE
Any data which are not saved will be lost if the power automatically turns off. Make sure to save your data before this happens.

Turning the power on or off

Disabling Auto Power Off 
Turn the power on while holding down the lowest key on the 
keyboard. An “Auto power off disabled” message appears 
briefly and the instrument starts up with the Auto Power Off 
disabled.

1

2 Power indicator

+
Lowest key
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To adjust the volume of the entire keyboard sound, use the [VOLUME] slider. Play the 
keyboard to check the sound while you adjust the volume. 

CAUTION
Do not use the instrument for a long period of time at a high or uncomfortable volume level, since 
this can cause permanent hearing loss.

NOTE
You can use the Volume Limiter function to prevent excessively loud sounds from the instrument. This function is 
set to off by default; however, you can turn it on/off from “Sound” > “Volume Limiter” in the System menu (page 51). 
For details, refer to the Reference Manual. 

You can connect two pairs of headphones to the [PHONES] jacks. If you 
are using only one pair, insert the plug into either of these jacks. If you 
use headphones with a mini plug, you will need an appropriate adaptor 
plug as shown in the illustration. 

CAUTION
Do not use the headphones for a long period of time at a high or uncomfortable 
volume level, since this can cause permanent hearing loss.

NOTE
• To prevent excessively loud volume, the Volume Limiter function can be used to limit the 

maximum volume. This function is set to off by default; however, you can turn it on/off from 
“Sound” > “Volume Limiter” in the System menu (page 51). For details, refer to the Reference 
Manual. 

• When a plug is connected to the [PHONES] jack, no sound will come out from the 
instrument's speakers. If you are using an adaptor plug, be sure to remove this as well when 
unplugging the headphones.

• When one of the Voices having VRM effects is selected (page 52), the Binaural Sampling or Stereophonic Optimizer technology lets you enjoy 
exceptionally realistic, natural piano sound, even when listening on headphones. This function is set to on by default; however, you can turn it on/off 
from “Sound” > “Binaural” in the System menu (page 51). For details refer to the Reference Manual.

Attaching the headphone hanger

A headphone hanger is included in the instrument package so that you 
can hang the headphones on the instrument. Attach the headphone 
hanger by using the included two screws (4 × 10 mm) at the left front 
side as shown in the illustration. 

NOTICE
Do not hang anything other than the headphones on the hanger. Otherwise, the 
instrument or the hanger may be damaged.

Adjusting the Master Volume 

Using headphones 

Increases 
the level.

Decreases 
the level.

Standard stereo phone jack

Adaptor plug 
(3.5 mm  
6.3 mm)

Stereo mini plug 
(3.5 mm)

* The shape of the hanger differs 
depending on the model
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The function below is assigned for each pedal by default. Before 
using the pedals, rotate the adjuster until it comes in firm contact 
with the floor surface so that the pedals do not rattle or give way 
when you step on them. 

NOTICE
Before moving the instrument, rotate the adjuster under the pedal until it 
separates from the floor surface. Failure to do so may damage the floor 
surface.

NOTE
• The pedals are protected with vinyl covers when shipped from the factory. Remove 

the covers from the pedals before using to ensure optimum use of the pedal 
effects.

• The pedal functions can be changed from “Pedal Assign” in the Voice menu 
(page 51). For details, refer to the Reference Manual.

 Damper pedal (right pedal) 
When you press the damper pedal, the notes you play have a longer sustain. 
When you select a piano Voice having VRM effects (page 52), pressing the 
damper pedal activates the VRM to accurately recreate the unique resonance.

NOTE
The damper pedal of the CLP-885, CLP-875 and CLP-895GP features the GP Response Damper. This 
special pedal has been designed to provide enhanced tactile response and, when pressed, is much 
closer in feel to the pedal of an actual grand piano. It makes it easier to physically experience the half-
pedal point and more easily apply the half-pedal effect than other pedals.

 Sostenuto pedal (center pedal) 
If you play a note or chord on the keyboard and press the sostenuto pedal while 
holding the note(s), the notes will sustain as long as the pedal is held. All 
subsequent notes will not sustain.

NOTE
While the center pedal is held, a sustained (non-decaying) type of Voice in the STRINGS or ORGAN 
category may sound continuously without decay after the notes have been released.

 Soft pedal (left pedal)
The soft pedal reduces the volume and slightly changes the timbre of notes played while the pedal is pressed. The 
soft pedal will not affect notes that are already playing when it is pressed.
When “Jazz Organ 1,” “Jazz Organ 2” or “Rock Organ” is selected, pressing and releasing this pedal switches 
between “fast” and “slow” of the Rotary Speaker speed. When the “Vibraphone” is selected, this pedal switches 
Vibrato on and off.

Using the pedals 

[PEDAL] connector 
Make sure to connect the plug of the pedal cord securely into the [PEDAL] connector in 
the proper direction. Otherwise, the pedal may not function properly. The FC35 Pedal 
Unit (sold separately) can also be connected to this terminal. You can substitute the 
FC35 for the pedals of the instrument, and use the pedals at a suitable height for you by 
placing the unit on a stand.

CAUTION
When placing the FC35 on a stand, make sure that the stand is sufficiently large, flat and stable to prevent the pedals from 
wobbling or falling when they are pressed.

NOTICE
Be careful to connect the plug in the proper direction. Connecting in the wrong direction can result in damage to the 
instrument.

NOTE
• On the CLP-895GP/CLP-865GP, the shape of the plug differs from the illustration above.
• Make sure that power is off when connecting or disconnecting the plug of the pedal.

Soft Pedal

Sostenuto Pedal

Damper Pedal

Presses against 
the floor 

Lifts from the 
floor

When you press the damper 
pedal here, the notes you play 
before you release the pedal 
have a longer sustain.

When you press the sostenuto 
pedal here while holding the 
note(s), the notes will sustain as 
long as you hold the pedal.

Insert the plug securely 
until the metal part of the 
plug disappears from view.
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Basic Operations

Since this instrument is optimized for first-time users by factory default, you can enjoy easily using it simply with the 
default settings. 
As you become more familiar with the instrument, try out some of the various functions or change some of the 
settings as desired. Use the control panel to control the instrument while checking the status of the instrument on 
the display. 

Control Panel 

NOTE
• The CLP-885/CLP-875/CLP-895GP and the CLP-845/CLP-835/CLP-865GP have different control panels. Panel illustration examples are hereafter 

indicated with the icons to show which models have that particular panel.

• On the CLP-885/CLP-875/CLP-895GP, the control panel lights up when the power is turned on, and it turns off automatically if you do not touch the 
control panel for a specified period time (30 seconds by default). The amount of time that elapses before the light turns off, and the sound on/off of the 
control buttons can be set from “Utility” in the System menu (page 51). For details, refer to the Reference Manual.

1 [CFX GRAND]/[BÖSENDORFER]/[PIANO ROOM] buttons
For playing this instrument as a piano (page 23). You can play the piano with your desired settings, such as 
touch sensitivity and the resonance.

2 [VOICE]/[DUAL/SPLIT] buttons
For playing with various instrumental Voices, including piano, organ and more (page 26). You can also layer two 
Voices, or play different Voices in the right- and left-hand areas of the keyboard.

3 [SONG/DEMO]/[REC]/[PLAY/PAUSE] buttons
For playing back and listening to the preset or commercially available Songs (page 30), or for recording your 
performance (page 37). You can also play back or record each part individually, allowing you to practice the 
right-hand part while playing back the left-hand part.

4 [METRONOME]/[RHYTHM] buttons
For practicing playing at an accurate tempo with metronome (page 25), or playing along with dynamic Rhythm 
playback (page 29).

5 [TEMPO] button
For adjusting the tempo for the metronome (page 25), Rhythm (page 29), or Song (page 33) playback.

 

885 875 895GP 845 835 865GP

1
1

2 2

3 3

4 45 5

Display

[MENU] button

[u]/[d]/[l]/[r]
buttons

[EXIT] button

Bluetooth button

Display

[u]/[d]/[l]/[r]
buttons

[MENU] button

[EXIT] button



Basic Operations

21 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Owner’s Manual

• [u]/[d]/[l]/[r] buttons
For selecting an item on the display or setting a value. Refer to the examples below as a guide for using these 
buttons.

• [ ]/[EXIT] buttons
For exiting from the setting display. 

• [≡]/[MENU] buttons (page 51)
For making detailed settings of each function. On the CLP-845, CLP-835 and CLP-865GP, this is also used for 
connecting a Bluetooth-equipped device such as a smartphone (page 44).

• (CLP-885/CLP-875/CLP-895GP only) Bluetooth button (page 44)
For connecting to a Bluetooth-equipped device such as a smartphone.

Bluetooth capability
Depending on the country in which you purchased the product, the instrument may not have Bluetooth 
capability. If the Bluetooth logo is shown or printed on the control panel, this means that the product is equipped 
with Bluetooth functionality.

In this manual, the [ ] button is hereafter referred to as the [EXIT] button, and the [≡] button is referred to as 
the [MENU] button.

Press the [u] 
button to call up a 
higher level (list).

Use the [l]/[r] 
buttons to select 
an item.

Press the [l] 
button to call up a 
higher level (list).

Use the [u]/[d] 
buttons to select 
an item.

Press the [r] 
button to enter a 
setting, execute 
an operation, or 
call up a lower 
level.

Use the [u]/[d] 
buttons to change 
the value.

Use the [l]/[r] buttons to 
select an item. Use the [l]/[r] buttons to 

change the value.

Use the [u]/[d] buttons to scroll 
through the display. (The scroll bar is 
shown when there are too many 
items to fit into one page.)

885 875 845895GP 835 865GP

Bluetooth logo

Bluetooth logo
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Restoring the factory-programmed settings

The settings of the instrument are retained even when the power is turned off, 
allowing you to use the instrument with the same settings when you turn the 
power on the next time. To reset the settings to their factory defaults, press 
the [P] (Standby/On) switch to turn on the power while holding down the 
highest key. 

NOTE
• For details on the data retained even when the power is turned off, refer to the “Backup” section in 

the System menu on the Reference Manual.

• The Songs saved to the instrument (page 37) and Bluetooth paring information (page 44) will not be 
lost even when the initializing is executed.

Resetting the value of the selected item to its default

You can reset the setting value for a selected item, such as in the Tempo display and Menu display, to its original 
default value.

Initializing the settings

Highest key

[P] (Standby/On) switch

885 875 845 835895GP 865GP

While the setting display is shown, 
press and hold the [MENU] button 
until the value is reset.

While the setting display is shown, 
press the [l] and [r] buttons 
simultaneously.

NOTE
On the display in which you set the value by 
using the [u]/[d] buttons, press the [u] and 
[d] buttons simultaneously to reset. 
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Enjoy Playing the Piano

This instrument lets you play with various types of piano sounds. Press the [CFX GRAND] or [BÖSENDORFER] 
button at first to play with an authentic grand piano.

• [CFX GRAND] button: 
Calls up Yamaha’s CFX concert grand piano sound (“CFX Grand” Voice) with a wide dynamic range for maximum 
expressive control. Suitable for playing in any music genre and style.

• [BÖSENDORFER] button: 
Calls up the famed sound of the Vienna-made Bösendorfer Imperial concert grand piano (“Bösendorfer” Voice). 
The warm, spacious sound evokes the size of the instrument, and is ideal for expressing tenderness in 
compositions.

NOTE
Pressing the [CFX GRAND] or [BÖSENDORFER] button disables the Dual, Split or Duo function (page 27).

The Piano Room lets you adjust detailed settings such as the resonance of the piano sound and Touch Sensitivity to 
customize your desired piano. Select “CFX Grand,” “Bösendorfer” or any other PIANO category Voices having VRM 
effects to apply the settings.

NOTE
To check which PIANO category Voices have VRM effects, refer to the “Voice List” on page 52.

Selecting other piano Voices
Use the [l][r] buttons to select piano Voices other than “CFX Grand” and “Bösendorfer.” You can also select 
other Voices by pressing the [VOICE] button (page 26).

Customizing the sound and the Touch Sensitivity of piano 
Voices (Piano Room)

885 875 845 835895GP 865GP

Voice display
Voice name

Voice display
Voice name
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1. Press the [PIANO ROOM] button to call up the Piano Room display.

NOTE
To exit from the Piano Room display, press the [EXIT] button.

2. Use the [u][d] buttons to select an item, and then use the [l][r] buttons to set the 
value.

Item Description

Lid Position Recreates the differences in sound depending on how high the (virtual) grand piano lid is opened.

Brightness Adjusts the brightness of the sound.

Touch Determines how the sound responds to your playing strength. 

Reverb Selects the Reverb type, which simulates the reverberation of a specific room or venue, giving you 
the feeling of being in the selected space. The Reverb depth can also be adjusted.

Reverb Depth

Master Tune Fine tunes the pitch of the entire instrument. This function is useful when you play this instrument 
along with other instruments or CD music.

VRM Turns on/off the VRM (Virtual Resonance Modeling) effect which faithfully simulates an actual 
acoustic piano. While this display is shown, pressing the [PLAY/PAUSE] button plays back the 
Demo. You can listen to the Demo with and without the effect (VRM on or off). The parameters 
below can be set when VRM is set to “On.”
• Damper Resonance: Adjusts the depth of the string resonance effect which is applied when the 

damper pedal (right pedal) is pressed.
• Damper Noise: Turns on/off the damper noise which recreates the sound made on an acoustic 

piano when the damper pedal is pressed.
• String Resonance: Adjusts the depth of the string resonance effect which is applied when a note 

on the keyboard is pressed.
• Duplex Scale Resonance: Adjusts the sympathetic vibrations of the duplex scaling resonance 

effect.
• Body Resonance: Adjusts the resonance of the piano itself (the soundboard, the sides, the frame 

and so on).

Grand 
Expression

Selects the type of the Grand Expression Modeling effects. While this display is shown, pressing the 
[PLAY/PAUSE] button plays back the Demo. You can listen to the Demo with “Dynamic” or “Static.”
• Dynamic: You can control extremely subtle nuances in the sound like on an actual acoustic piano 

by changing your playing strength or touch.
• Static: The nuances are generally fixed even when you change your playing strength or touch.

885 875 845 835

1

2

1

2

895GP 865GP

Piano Room 
display

Piano Room 
display
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NOTE
• The settings in the Piano Room are equivalent to those in the Menu display (page 51). “Touch,” “Master Tune” and “Half Pedal Point” can be set 

in the System menu, and other parameters can be set in the Voice menu. For details on these setting parameters, refer to the Reference 
Manual.

• To reset the selected item to the default value, on the CLP-885, CLP-875 and CLP-895GP, press and hold the [MENU] button until the until the 
value is reset. On the CLP-845, CLP-835 and CLP-865GP, press the [l] and [r] buttons simultaneously.

Pressing the [METRONOME] button turns the metronome on/off. The metronome lets you practice or play at an 
accurate tempo.
To adjust the metronome tempo, use the [l]/[r] buttons to change the value while the Tempo display is shown. If 
the Tempo display is not shown, press the [TEMPO] button to call it up.

NOTE
• The tempo of the metronome and the Rhythm (page 29) are equivalent.

• If you set the time signature of the metronome, the first beat is accented by the bell sound. The time signature and the volume of the metronome can 
be set in the Metronome/Rhythm menu (page 51). For details, refer to the Reference Manual.

Half Pedal 
Point

Specifies the point to which you must depress the damper pedal (right pedal) before the Sustain 
effect begins to be applied.

Half-pedal function
The Half-pedal function allows you to use half-damper techniques, in which the damper is pressed somewhere 
between all the way down and all the way up. In this half-damper state (on a real piano), the damper felts only 
partially mute the strings. The Half-pedal function on this instrument lets you delicately and expressively control the 
damper muting, and create subtle nuances in your performance, by finely controlling the point at which pressure on 
the pedal affects the damper muting.

Using the metronome

Item Description

885 875 845 835895GP 865GP

Tempo display Tempo display

Metronome on/off Metronome on/off

Adjusting 
the tempo

Adjusting 
the tempo
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Playing with Various Sounds (Voices)

In addition to the wonderfully realistic piano sounds, you can select and play other musical instrument sounds 
(Voices), such as organ or stringed instruments. For details on each Voice, refer to the Voice List on page 52.

NOTE
Demos are provided for some Voices, allowing you to hear and experience the characteristics of the Voices. Refer to page 31 for instructions on playing 
back the Voice Demos.

1. Press the [VOICE] button to call up the Voice category list.
Voices are categorized by the type of instrument.

2. Use the [u]/[d] buttons to select the Voice category, and then press the [r] button call 
it up.
The Voices in the selected category are listed in the display. To re-select the category, press the [l] button.

NOTE
On the CLP-885 and CLP-895GP, XG Voices can also be selected. Since the XG category contains a large number of Voices, it is conveniently 
divided into sub-categories. Use the [u]/[d] buttons to select a sub-category, and then press the [r] button to go on to the next step. For a list of 
XG Voices, refer to the Data List on the website.

3. Use the [u]/[d] buttons to select the desired Voice, and then press the [r] button to 
call it up.
The Voice display appears with the current Voice.

NOTE
You can also change the Voice by using the [l]/[r] buttons while the Voice display is shown. 

4. Play the keyboard.

885 875 845 835895GP 865GP

Voice categories
Voice categories

Voice category

Voice

Voice display
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The Dual function lets you play two different Voices in a layer, and the Split function lets you play different Voices in 
the right- and left-hand areas of the keyboard. The Dual and Split functions can be used at the same time. By 
combining Voices, you can create luscious instrument textures and convenient performance combinations.
When Split is turned on, the key which divides the keyboard into the left- and right-hand areas is referred to as Split 
Point, and it is set to the key indicated in the illustration below by default. The Split Point key is included in the left-
hand area.

1. Press the [DUAL/SPLIT] button several times to turn on the Dual/Split function.
Depending on the function you wish to use, press the button once, twice or three times. The display differs 
depending on the activated function.

Combining Voices for playing (Dual/Split)

1

2

L R

R1

R2
L

Dual

Split

Dual + Split

Voice 1

Voice 2

Right 1 Voice

Right 2 Voice

Right VoiceLeft Voice

Left Voice

Split Point (F#2 as default) Center “C” (C3)

885 875 845 835

2

1

2

1

895GP 865GP

Right 1 Voice

Right 2 Voice

Right Voice

Left Voice

Left Voice

Voice 1

Voice 2

Dual: Press the button once

Split: Press the button twice

Dual + Split: Press the 
button three times
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2. Select two or three Voices.
2-1. Use the [u]/[d] buttons to select the part (1/2, R/ L, or R1/R2/L).
2-2. Use the [l]/[r] buttons to select the Voice.

You can also select the Voice by pressing the [VOICE] button to call up the Voice category list (page 26).

3. Play the keyboard.

4. After you finish your performance, press the [DUAL/SPLIT] button to turn off the Dual/
Split function.

Changing the Split Point (the border between the right- and left-hand areas)

With the Split function turned on, simultaneously hold down the [DUAL/SPLIT] button and press the key you wish to 
set as the Split Point. The specified Split Point key is included in the left-hand area.

Playing by two players over the same octave range (Duo)
The Duo function allows two different players to play the right and left area of the keyboard which is divided at 
the Split Point. Two players can play over the same octave range. You can turn this function on/off from 
“Keyboard” in the System menu (page 51). For details, refer to the Reference Manual.

NOTE
When Duo is turned on, the right pedal becomes the damper pedal for the right player, the left pedal becomes the damper pedal for the left player, 
and the center pedal becomes the damper pedal for both the right and left player.

Split Point (F#2 as default) Center “C” (C3)
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Playing the Keyboard along with Rhythm 
Playback

Using the Rhythm function instead of the metronome lets you not only play with accurate tempo but also lets you 
perform more enjoyably along with dynamic Rhythm playback in the desired music genre.

1. Press the [RHYTHM] button to start Rhythm playback.
Intro playback starts followed by the Rhythm playback.

2. Use the [l]/[r] buttons to call up the desired Rhythm.

3. Play the keyboard along with Rhythm playback.
The Rhythms consist of drums and bass accompaniment. The bass accompaniment sound automatically 
changes based on the chords played on the keyboards.

The Rhythm tempo is equivalent to the metronome tempo (page 25). Press the [TEMPO] button and then use 
the [l]/[r] buttons to adjust the tempo.

NOTE
• For details on how to play chords, refer to commercially available chord books. 9th, 11th and 13th chords cannot be recognized.

• The volume, bass sound on/off, and Intro and Ending on/off can be set in the Metronome/Rhythm menu (page 51). For details, refer to the 
Reference Manual.

4. To stop Rhythm playback, press the [RHYTHM] button again.
The Rhythm will automatically stop after an Ending is played.

885 875 845 835
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Playing back Songs such as Preset Songs and 
Recorded Songs

Preset songs, your recorded performances, and commercially available songs that can be played back on this 
instrument are referred to as “Songs” in this manual. In addition to listening to these Songs, you can use the Songs 
for your practice. 

There are two kinds of Songs as described below. 

• MIDI Songs
A MIDI Song is comprised of your keyboard performance information and is not a recording of the actual sound 
itself. The performance information refers to which keys are played, at what timing, and at what strength—just as 
in a musical score. Based on the recorded performance information, the sounds built into the instrument is output 
from the speakers. MIDI Songs are useful for practicing; you can play back the right-hand and left-hand parts 
independently, and you can also play back the specified range of the Song repeatedly.

• Audio Songs
An Audio Song is a recording of the performed sound itself. This data is recorded in the same way as that used 
with voice recorders, etc.

Songs that can be played back on this instrument
• Preset MIDI Songs (see “Song List” on page 57)

• MIDI Songs/Audio Songs recorded on this instrument (see page 37 for instructions on recording)

• Commercially available Songs of the following formats in the USB flash drive connected to the USB [TO 
DEVICE] terminal
- MIDI Songs: SMF (Standard MIDI File)
- Audio Songs: WAV (44.1 kHz, 16-bit, stereo)

NOTE
Before using a USB flash drive, be sure to read “Using the USB [TO DEVICE] terminal” on page 6.
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1. (Only when playing a Song from a USB flash drive) Connect the USB flash drive to the USB [TO 
DEVICE] terminal.

2. Press the [SONG/DEMO] button to call up the Song category list.

NOTE
• For a list of the preset Songs, refer to the “Song List” on page 57. To see which Voices have Demos, refer to the “Voice List” on page 52.

• “USB” appears only when a USB flash drive is connected.

• Copying or moving MIDI Songs from a USB flash drive to “User” can be done from “File” in the Song menu (page 51). For details, refer to the 
Reference Manual.

• By using the Smart Pianist app (page 46), you can view the music scores of the “50 Classics” and “Lesson” Songs on your smart device.

3. Use the [u]/[d] buttons to select the Song category (folder), and then press the [r] 
button to call it up.
The Songs in the selected folder are shown. If the folder contains another folder within it, repeat the same 
operation. To re-select a folder, press the [<] button to return to the Song category list.

Song category Format Description

Demo MIDI
Voice Demos let you experience the characteristics of the Voices (page 26). 
Demos are available only for some Voices.

50 Classics MIDI
Preset piano Songs which are contained in the music book “50 Classical Music 
Masterpieces,” included with this instrument.

Lesson MIDI
Preset Songs ideal for practice, taken from “The Virtuoso Pianist” and others. 
Lesson Songs are divided into several folders depending on the album types.

User MIDI
Songs which have been recorded and saved to the instrument by using the Record 
function (page 37), and Songs which have been copied/moved to the instrument 
from a USB flash drive.

USB
MIDI Songs saved to the USB flash drive connected to the USB [TO DEVICE] terminal. 

The Songs recorded on this instrument are saved to the “USER FILES” folder.Audio

5
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4. Use the [u]/[d] buttons to select the Song, and then press the [r] button to call it up.
The Song display appears, and you can see the currently selected Song name and its category name.

NOTE
When the Song name is too long to be displayed, press the [d] button to see the full name.

5. Press the [PLAY/PAUSE] button to start playback.
The current position of Song playback appears in the display. The current measure number is shown for MIDI 
Songs, and the elapsed time is shown for Audio Songs. The [PLAY/PAUSE] button flashes during playback.

The Song stops automatically when playback of the selected Song reaches the end. To pause the Song during 
playback, press the [PLAY/PAUSE] button.

Fast forward/Rewind

While the Song display is shown, press the [l] button to rewind, and press the [r] button to fast forward. The 
display shows you the current playback position (measure number/elapsed time).

Returning to the Song beginning

• CLP-885/CLP-875/CLP-895GP: While the Song display is shown, hold the [MENU] button until the Song position 
returns to the beginning.

• CLP-845/CLP-835/CLP-865GP: While the Song display is shown, press the [l] and [r] buttons simultaneously.

Fast forward/Rewind/Returning to the Song beginning

Song name

Song display (MIDI Song)

Category name

Song name

Song display (Audio Song)

Category name

Song display (MIDI Song) Song display (Audio Song)

Current position Measure number Current position Elapsed time (min.: sec.)
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1. During Song playback, press the [TEMPO] button to call up the Tempo display.
When a MIDI Song is selected and the Song display is shown, you can call up the Tempo display while the 
Song is stopped.

2. Use the [l]/[r] buttons to change the tempo.
For MIDI Songs, the tempo range differs depending on the time signature for the selected Song. For Audio 
Songs, tempo can be adjusted over a range of 75%–125%, with 100% being the original speed.

NOTE
When a MIDI Song is selected, only even numbers are available for the tempo value depending on the time signature for the selected Song. For 
details, refer to the “Time Signature” section in the Metronome/Rhythm menu in the Reference Manual.

To reset to the original tempo, follow the instructions below.
• CLP-885/CLP-875/CLP-895GP: Hold the [MENU] button until the tempo resets to the default value.
• CLP-845/CLP-835/CLP-865GP: Press the [l] and [r] buttons simultaneously.

Playing back an entire Song or Songs repeatedly

You can play back the selected Song or all Songs in the selected folder continuously. 

1. Select a Song to be played back (page 31).

2. Press the [MENU] button several times to call up the Song menu (page 51).

3. Use the [u]/[d] buttons to select “Repeat,” and then press the [r] button to call up the 
function. 

Adjusting the tempo/speed

Using repeat playback

Tempo display (MIDI Song) Tempo display (Audio Song)

Tempo value Percentage 
compared to the 
original speed
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4. (Only for when a MIDI Song is selected) Use the [u]/[d] buttons to select “Song,” and then 
press the [r] button to call up the function.
When an Audio Song is selected, this step is not needed.

5. Use the [u]/[d] buttons to select the repeat type.

• Off: Disables repeated playback. When playback of the selected Song reaches the end, playback stops 
automatically.

• Single: Plays through only the selected Song repeatedly.
• All: Continuously plays back all Songs in the folder which contains the selected Song in numerical order.
• Random: Continuously plays back all Songs in the folder which contains the selected Song in random order.

6. Press the [PLAY/PAUSE] button to start playback.
If you call up the Song display by pressing the [EXIT] button, you can check the status of repeat playback.

Playback continues until you press the [PLAY/PAUSE] button again. To stop repeated playback, select “Off” in 
the display of step 5.

Playing back a specified range of a Song repeatedly (A-B Repeat; MIDI 
Songs only)

A specified range of the selected MIDI Song can be played back repeatedly. This is referred to as the A-B Repeat 
function, and lets you practice a part of a Song repeatedly.

1. Select a MIDI Song to be played back (page 31).

2. Press the [MENU] button several times to call up the Song menu (page 51).

3. Use the [u]/[d] and [r] buttons to select “Repeat” followed by “A-B” and call up the A-
B Repeat display.

Single

All

Random

A-B Repeat display
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4. Press the [PLAY/PAUSE] button to start playback.
NOTE
To specify the top of the Song as the starting point (A), first go to step 5, and then start playback. After that, go on to step 6.

5. Press the [r] button at the starting point (A) of the range to be repeated.

6. Press the [r] button again at the ending point (B).
After an automatic lead-in (to help guide you into the phrase), the range from Point A to Point B is played back 
repeatedly. To pause the Song at any time, press the [PLAY/PAUSE] button. 

NOTE
To specify the end of the Song as the ending point (B), play back through until the end of the Song. The point B is automatically set without you 
needing to press any button.

If you call up the Song display by pressing the [EXIT] button, the icon ( ) is shown at the upper right of the 
display, indicating that the A-B Repeat function is turned on.

7. To disable A-B Repeat, press the [r] button in the A-B Repeat display while “Repeat 
Off” is selected.

Selecting another Song also disables A-B Repeat.

Some MIDI Songs, such as preset Songs in the “50 Classics” and “Lesson” are divided into right-hand and left-hand 
parts. When playing this Song data, you can play the keyboard with one hand while playing back the other hand’s 
part—allowing you to practice parts separately for easy mastery of difficult material.

1. Select a Song for practicing (page 31).

2. Press the [MENU] button several times to call up the Song menu (page 51).

Another method for specifying a repeat range 
1. Press the [u] button to highlight the measure number, and then use the 

[l]/[r] buttons to select the desired measure for point A.

2. Press the [d] button to highlight “Set A,” and then press the [r] button 
to enter the setting.

3. Specify point B in the same way as point A. 

Practicing a one-hand part along with Song playback (MIDI 
Songs only)

65
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3. Use the [u]/[d] buttons to select “L/R,” and then press the [r] button to call up the 
function.

4. Use the [u]/[d]/[l]/[r] buttons to set the desired part for practicing—“R” (Right) or 
“L” (Left)—to “Off.”
The part set to “Off” will be muted.

NOTE
• Parts having no data are indicated by a “---” mark. 

• A MIDI Song consists of 16 tracks (parts), and usually track 1 is assigned to “R,” track 2 is assigned to “L,” and tracks 3−16 are assigned to 
“Extra.” 

• If you select another Song, all parts will be reset to on.

5. Press the [PLAY/PAUSE] button to start playback and practice playing the part you have 
turned off.
The Song stops automatically when playback of the selected Song reaches the end. To pause the Song during 
playback, press the [PLAY/PAUSE] button.

To practice more effectively, you can conveniently adjust the tempo (page 33) and use the A-B Repeat function 
(page 34).

The additional functions below are useful for Song playback and can be set in the Menu display (page 51). For 
details, refer to the Reference Manual.

• Starting/pausing playback by using a pedal: This can be set from “Pedal” > “Play/Pause” in the System menu.

• Transposing the pitch of a Song: This can be set from “Transpose” in the Song menu.

• Adjusting the volume balance between your keyboard performance and Song playback: This can be set 
from “Volume” in the Song menu.

Other useful Song playback functions
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Recording Your Performance

This instrument features two different recording methods that you can use depending on your purposes.

• MIDI Recording
With this method, recorded performances are saved as an SMF (format 0) MIDI Song to the instrument or a USB 
flash drive. A MIDI Song uses a small amount of data capacity in comparison to an Audio Song. MIDI recording 
allows you to record each part (such as right- and left-hand parts) separately. Since a MIDI Song can be edited, if 
you want to re-record a specific section or change parameters such as Voice, use this method. Since a MIDI Song 
can be converted to an Audio Song after recording, you may want to first use MIDI recording (with overdubbing 
and multiple parts) to create a complex arrangement you would not otherwise be able to play live, and then 
convert it to an Audio Song. This instrument allows you to record approximately 500 KB of data per Song.

• Audio Recording
With this method, recorded performances are saved to a USB flash drive as an Audio Song in WAV format 
(44.1 kHz, 16-bit, stereo). Audio input sound from the connected external device (computer, smartphone, audio 
player, etc.) can also be recorded along with your keyboard performance. This instrument allows you to record up 
to 80 minutes per single recording.

NOTE
• In this manual, “audio input sound” refers to audio data that is input to the instrument from connected external devices using one of these methods: 

USB Audio Interface function, Bluetooth Audio function (page 43), [AUX IN] jack (page 45) or Wi-Fi (page 47). 

• MIDI Songs can be converted to Audio Songs from “File” > “MIDI to Audio” in the Song menu (page 51). For details, refer to the Reference Manual.

This section explains how to record a new performance and save it to the instrument as a MIDI Song.

1. Make the necessary settings such as Voice selection.
If you want to use functions such as Dual, Split and metronome, turn them on here. 
If you want to play back Rhythm, select it here, but make sure to start playback in step 3. If you start Rhythm 
playback here, going on to the next step stops playback.

NOTE
The metronome sound is not recorded. Rhythm is recorded by default; however, you can set whether Rhythm is recorded or not in the Recording 
menu (page 51).

2. Press the [REC] button to set recording to standby.
The REC display appears and the [PLAY/PAUSE] button flashes.

Recording to the instrument (MIDI recording)
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NOTE
If you press and hold the [REC] button for a while, a list appears letting you select the recording target Song (step 3 on page 39). From that list 
select “New MIDI.”

3. Start recording and play the keyboard.
Playing the keyboard automatically starts recording. If you want to record some silence at the start of the Song, 
press the [PLAY/PAUSE] button to start recording. While recording, the measure number in the display 
advances.
If you want to record with Rhythm playback, press the [RHYTHM] button at the timing you want to start Rhythm 
playback. To start recording and Rhythm playback at the same time, press the [RHYTHM] button to start 
recording.

4. After you finish your performance, press the [REC] button again to stop recording.

5. In the “Confirm” display, use the [u]/[d] buttons to select “Save,” and then press the 
[r] button to save the data.
If you want to record again, select “Retry” and return to step 3.
If you do not want to save the data and exit from this display, select “Cancel.”

After the operation is completed, a “Save Completed” message appears and operation returns to the Song 
display. The recorded Song is named “USERSONG***” (***: number) and saved in the “User” category 
(page 31).

NOTICE
The recorded Song will be lost if you change to another Song or you turn the power off without executing the Save operation.

NOTE
You can rename the Song name as desired from “File” in the Song menu (page 51). For details, refer to the Reference Manual.

6. Press the [PLAY/PAUSE] button to listen to the recorded performance.

885 875 845 835895GP 865GP
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This section explains how to record a new performance and save it to the USB flash drive as a MIDI Song or an 
Audio Song.

NOTE
Before using a USB flash drive, be sure to read “Using the USB [TO DEVICE] terminal” on page 6.

1. Connect the USB flash drive to the USB [TO DEVICE] terminal.

2. Make the necessary settings such as Voice selection.
If you want to use functions such as Dual, Split and metronome, turn them on here.
If you want to play back Rhythm, select it here, but make sure to start playback in step 6. If you start Rhythm 
playback here, going on to the next step stops playback.

NOTE
The metronome sound is not recorded. Rhythm is recorded by default; however, you can set whether Rhythm is recorded or not in the Recording 
menu (page 51).

3. Press and hold the [REC] button for a second to call up a list of recording target Songs.

4. Use the [u]/[d] buttons to select “New MIDI (USB)” or “New Audio (USB).”
• New MIDI (USB): For recording a new MIDI Song and saving it to the USB flash drive.
• New Audio (USB): For recording a new Audio Song and saving it to the USB flash drive.

NOTE
• “New MIDI (USB)” and “New Audio (USB)” can be selected only when a USB flash drive is connected to the USB [TO DEVICE] terminal.

• “New MIDI” is for recording a new MIDI Song and saving it to the instrument (same as step 2 on page 37).

5. Press the [r] button to set recording to standby.
The REC display appears and the [PLAY/PAUSE] button flashes.

6. Follow the same operations as steps 3–6 on page 38.
The recorded Song will be named “USERSONG***.mid” for MIDI Songs, and “USERAUDIO***.wav” for Audio 
Songs (***: number), and is saved in the “USER FILES” folder of the USB flash drive. 

Recording to a USB flash drive (MIDI recording/Audio recording)
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With MIDI recording, you can record right-hand and left-hand parts independently and save them as a single Song. 
This lets you create a piece that would be difficult play live with both hands together. This can also be convenient for 
letting children practice, for example, by recording the performance of a parent or teacher, and having the child can 
play one hand part along with playback of the model part.

1. Make the necessary settings such as Voice selection.
If you want to save the recorded data to a USB flash drive, connect a USB flash drive to the USB [TO DEVICE] 
terminal.

2. Press the [REC] button to set recording to standby.
The REC display appears and the [PLAY/PAUSE] button flashes. 

NOTE
To record to the USB flash drive, hold the [REC] button until the list of recording target Songs (step 3 on page 39) appears, and then select “New 
MIDI (USB).”

3. Use the [l]/[r] buttons to select the first part to record: “R” (Right-hand) or “L” (Left-
hand).

4. Start recording and play the keyboard.
Playing the keyboard automatically starts recording. If you want to record some silence at the start of the Song, 
press the [PLAY/PAUSE] button to start recording.

5. After you finish your performance, press the [REC] button again to stop recording.

6. In the “Confirm” display, use the [u]/[d] buttons to select “Save,” and then press the 
[r] button to save the data.
If you want to record again, select “Retry” and return to step 3.
If you do not want to save the data and exit from this display, select “Cancel.”

After the operation is completed, a “Save Completed” message appears and operation returns to the Song 
display. The recorded Song will be named “USERSONG***” (***: number) and is saved in the “User” category 
(page 31).

NOTICE
The recorded Song will be lost if you change to another Song or you turn the power off without executing the Save operation.

7. Press the [PLAY/PAUSE] button to listen to the recorded performance.

8. Press and hold the [REC] button for a second to call up a list of the recording target 
Songs.

Recording the right- and left-hand parts independently (MIDI 
recording)

REC display

Recording part
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9. Use the [d] button to select the MIDI Song (at the bottom of the list) saved in step 6, 
and then press the [r] button.

10.Use the [l]/[r] buttons to select the second part to record: “R” (Right-hand) or “L” 
(Left-hand).

NOTICE
Keep in mind that recording your performance to a part (track) containing data will overwrite the previously recorded data.

11. Follow the same operations as steps 4–6, and overwrite the recorded data.
While recording, the previously recorded part is played back.
After saving the data, press the [PLAY/PAUSE] button to listen to the recorded performance.

NOTE
• If you want to re-record one part after saving the data, start from step 8. If your desired Song is not shown in step 9, press the [SONG] button 

and select the desired Song, and then start from step 8 again. In step 10, select the part to re-record.

• To delete the data of one part, select the desired part (track) from “Edit” > “Track Delete” in the Song menu (page 51). “R” is the same as 
track 1, and “L” the same as track 2. For details, refer to the Reference Manual.

Overdubbing multiple parts (multi track recording)

With MIDI Recording, you can create a MIDI Song consisting of 16 tracks by recording your performance to each 
track one by one. 
As described in the section above, the right-hand part was recorded to “R” (track 1), and then the left-hand part was 
recorded to “L” (track 2). In step 3 or 10, another track from “Track3” – “Track16” can be selected, allowing you to add 
recording data to additional tracks and save everything together as a Song. In this way, you can record a Duet Song 
only by yourself, or you can create even more complex Songs.

• When Dual/Split/Duo is on (page 27), only the Right 1 Voice (for Dual) and Right Voice (for Split/Duo) performance 
is recorded to the selected track. The Right 2 Voice (for Dual) will be recorded to the track number which is 6 plus 
the selected track, and the Left Voice (for Split/Duo) will be recorded to the track number which is 3 plus the 
selected track. If the track number exceeds 16, the track count starts again from the top. 

• When recording the Rhythm (page 29), you cannot freely select desired tracks. The drum part is recorded to 
Tracks 9 and 10, and the bass part is recorded to Track 11.

NOTICE
Note that recording your performance to a track containing data will overwrite the previously recorded data. Take special notice 
when Dual, Split or Duo is on, because the recording tracks are automatically assigned. To see which track contains data, check 
the REC display (step 10 above).

NOTE
The data in each track can be played back individually from “Others” > “Play Track” in the Song menu (page 51). For details, refer to the Reference 
Manual.

Recording part (track)

Track data status

 : Contains data

 : Contains no data

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16Example of 
recording tracks

Right-hand part

Left-hand part

Right 2 Voice 
in Dual

Rhythm 
(bass part)

Rhythm 
(drum part)
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You can delete Songs recorded and saved in the instrument or USB flash drive. You can delete the selected Song 
one by one, or delete all “User” category Songs in the instrument, or delete all Songs in the “USER FILES” folder of 
the connected USB flash drive.

NOTE
The Songs in the folder contained in the “USER FILES” folder of the USB flash drive are not deleted.

1. Select the desired Song (page 31) to delete.
To delete all “User” category Songs in the instrument or delete all Songs in the “USER FILES,” select any one 
of the Songs in the folder.

2. Press the [MENU] button several times to call up the Song menu (page 51).

3. Use the [u]/[d] buttons to select “File,” and then press the [r] button to call up the 
function.

4. Use the [u]/[d] buttons to select “Delete” or “Delete All,” and then press the [r] 
button to actually select it.

5. Use the [u]/[d] buttons to select “Execute,” and then press the [r] button to actually 
execute the operation.
An “Executing” message appears. After the operation is completed, a “Completed” message appears and 
operation returns to the Song selection display.

NOTICE
Do not turn off the power or disconnect the USB flash drive while “Executing” is shown in the display. Doing so may damage 
the data.

NOTE
To delete the data of each part (track), use “Edit” > “Track Delete” in the Song menu (page 51). For details, refer to the Reference Manual.

Data recorded to MIDI Songs

Data for each part
• Note data (keyboard performance)
• Voice selection
• Pedal operations (Damper, Soft, Sostenuto)
• Grand Expression Modeling data
• Following settings that can be set in the Voice menu (page 51)

- Voice Edit 
Octave, Volume, Reverb Depth, Chorus Depth, Effect, Effect depth, Pan, 
Harmonic Content, Brightness, Touch

- Balance 
Detune (only when Dual is turned on)

Data commonly for all parts
• Scale
• Tempo
• Time Signature
• Reverb type
• Chorus type

Deleting the recorded Songs

3 4 5

Song menu
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Connecting to Other Devices

Connecting external devices to this instrument provides even greater convenience performance options. For 
information on the location of these connectors, refer to “Panel Controls and Terminals” on page 12.

CAUTION
Before connecting the instrument to other electronic devices, turn off the power of all the devices. Also, before turning any devices 
on or off, make sure to set all volume levels to minimum (0). Otherwise, damage to the devices, electrical shock, or even permanent 
hearing loss may occur.

NOTICE
Do not place any devices in an unstable position. Doing so may cause the device to fall and result in damage.

Connecting an audio player such as smartphone or tablet to the instrument allows you to output audio from that 
connected device from the instrument’s speakers. The audio player can be connected via the Bluetooth Audio 
function, [AUX IN] jack, or USB [TO HOST] terminal.

Connecting via Bluetooth (Bluetooth Audio function)

A Bluetooth-equipped audio player can be connected by the Bluetooth Audio function. Audio playback on the 
connected device is output from the built-in speakers of this instrument.

NOTE
• Depending on the country in which you purchased the product, the instrument may not have Bluetooth capability (page 21).

• In order to use the Bluetooth function via wireless communication, the audio player must be equipped for transmitting audio data. For proper 
operation, the device must be compatible with A2DP (Advanced Audio Distribution Profile). 

• Since this instrument cannot transmit audio data to external devices via Bluetooth, Bluetooth headphones or speakers cannot be connected.

To connect via Bluetooth, the Bluetooth function of this instrument should be turned on. By default, the Bluetooth 
function is set to on, however you can turn it on/off from “Bluetooth” in the System menu (page 51). For details, refer 
to the Reference Manual.

Listening to audio player playback through the instrument’s 
speakers

Before using the Bluetooth function, be sure to read “About Bluetooth” on page 7.

Instrument
Bluetooth-equipped 

audio player

Bluetooth Audio
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1. (CLP-885/CLP-875/CLP-895GP) Hold down the [ ] (Bluetooth) button for 3 seconds. 
(CLP-845/CLP-835/CLP-865GP) Hold down the [MENU] button for 3 seconds.
A message appears indicating that the instrument is set to standby for pairing (registering) the Bluetooth-
equipped device.

To cancel the pairing, press the [EXIT] button.

2. On the audio player, set the Bluetooth function to on and select “CLP-*** (model name) 
AUDIO” from the connection list.
For details, refer to the audio player’s manual. After pairing is completed, the connection status will be shown 
in the display.

NOTE
• Make sure to complete the settings on the audio player within 5 minutes.

• Only one smart device can be connected to this instrument at a time (although up to 8 smart devices can be paired to this instrument). When 
pairing with the 9th smart device has succeeded, pairing data for the device with the oldest connection date will be deleted.

• If you are required to enter a passkey, enter the numerals “0000.”

3. Play back audio data on the audio player to confirm that the speakers of the instrument 
can output audio sound.
When you turn on the instrument the next time, the last-connected audio player will be connected to this 
instrument automatically, if the Bluetooth function of the audio player and the instrument is set to on. If it is not 
connected automatically, select the model name of the instrument from the connection list on the audio player 
again.

885 875 845 835895GP 865GP

Indicates audio data 
can be received



Connecting to Other Devices

45 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Owner’s Manual

Connecting with an audio cable ([AUX IN] jack)

You can connect the headphone jack of an audio player to the instrument’s [AUX IN] jack by using an audio cable. 
Audio playback on the connected device is output from the built-in speakers of this instrument.

NOTICE
To avoid damage to the devices, first turn on the power to the external device, and then to the instrument. When turning off the 
power, do in reverse: first turn off the power to the instrument, and then to the external device.

NOTE
Use audio cables and adaptor plugs having no (zero) resistance.

Connecting with a USB cable (USB [TO HOST] terminal)

By using a USB cable and a USB conversion adaptor, you can connect an audio player (or smart device such as 
smartphone) to the USB [TO HOST] terminal of the instrument. With this connection, the instrument can be used as 
a USB audio interface, allowing audio data to be transmitted and received between the instrument and the 
connected device. For details, refer to page 48.

NOTICE
Use an AB type USB cable of less than 3 meters. USB 3.0 cables cannot be used.

Instrument

Phone plug (stereo mini) Phone plug (stereo mini)

Audio player

Audio cable

Headphone jack

Audio signal

Example
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By connecting to a smart device such as a smartphone or tablet and using Smart Pianist, you have access to a 
variety of exceptionally convenient functions, such as viewing music scores and recording your performances to the 
device. The intuitive visual interface also helps you confirm the current settings of the instrument. 

For details on the app and compatible devices, access the website below and check the “Smart 
Pianist” page.

https://yamaha.com/kbdapps/

After installing the Smart Pianist app on your smart device, connect this instrument to the device via USB cables, 
Bluetooth or wireless LAN (Wi-Fi). For instructions on how to connect the device and use the app, refer to the 
“Smart Pianist User Guide.”

NOTICE
All settings on the instrument are replaced by the settings on Smart Pianist when the instrument is connected with Smart Pianist.

NOTE
While Smart Pianist is connected, you cannot use the control panel on the instrument. Use Smart Pianist to control the instrument. To disconnect Smart 
Pianist, close Smart Pianist on the smart device or press the [EXIT] button on the instrument. 

Connecting via Bluetooth

To connect the instrument and a smart device via Bluetooth, you need to make Bluetooth MIDI and Bluetooth Audio 
settings individually. In order to use Smart Pianist, Bluetooth MIDI connection is necessary. For listening to audio 
data on the smart device from the instrument, Bluetooth Audio connection is required as well. 
Once Bluetooth connection has been made successfully, the connection status appears on the display. 

NOTE
• Depending on the country in which you purchased the product, the instrument may not have Bluetooth capability (page 21).

• When the device is connected by Bluetooth, you cannot record in audio format by using Smart Pianist. To enable audio recording, connect via USB 
cable (page 47) or Wi-Fi (page 47).

1. Connect the instrument and the smart device by Bluetooth Audio (page 44).

When the connection is successful, audio data can be received on the instrument. This lets you listen to audio 
playback on the smart device from the instrument’s speaker.

Using the convenient Smart Pianist app

Before using the Bluetooth function, be sure to read “About Bluetooth” on page 7.

Indicates MIDI data can be 
transmitted/received

Indicates MIDI data can be 
transmitted/received, and 
audio data can be received

Instrument

Smart device

Bluetooth Audio

https://yamaha.com/kbdapps/
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2. By using the Smart Pianist app, connect the instrument and the smart device by 
Bluetooth MIDI.
For details on connection, refer to the “Smart Pianist User Guide.” Make sure to select “CLP-*** (model name) 
MIDI” for pairing.

When the connection is successful, MIDI data can be transmitted/received between the instrument and the 
smart device. This lets you record your keyboard performance in MIDI format to the smart device, or listen to 
the MIDI Song played on the smart device from the instrument’s speaker.

Connecting with a USB cable (USB [TO HOST] terminal)

By using a USB cable and a USB conversion adaptor, you can connect a smart device to the USB [TO HOST] 
terminal on the instrument. For instructions on connection, refer to “Smart Pianist User Guide.”

NOTICE 
Use an AB type USB cable of less than 3 meters. USB 3.0 cables cannot be used.

Connecting via wireless LAN (Wi-Fi) by using the UD-WL01 (sold separately)

To enable Wi-Fi connection, the separately sold UD-WL01 USB wireless LAN adaptor is required. Connect the USB 
wireless LAN adaptor to the USB [TO DEVICE] terminal. Before using the USB wireless LAN adaptor, be sure to 
read “Using the USB [TO DEVICE] terminal” on page 6.
For instructions on connection, refer to “Smart Pianist User Guide.”

NOTICE
Do not connect this product to a public Wi-Fi and/or Internet service directly. Only connect this product to the Internet through a 
router with strong password protections. Consult your router manufacturer for information on optimum security practices.

Bluetooth MIDI

Instrument

Smart device

Instrument

Smart device

USB cable

USB conversion adaptor

Example

MIDI data/Audio data

Access point 
(router)

USB wireless LAN adaptor 
(UD-WL01)

Instrument

Smart device

Example

Wireless 
LAN

Wireless 
LAN
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The instrument can be connected via Wi-Fi directly without need of an access point. However, in this condition 
Internet access will be disabled on your smart device, and some functions of Smart Pianist (such as data export/
import to and from online storage, firmware update) cannot be used.

NOTE
• The USB wireless LAN adaptor (UD-WL01) may not be available depending on your area.

• An “access point” refers to a device which acts as a base station when data is transmitted/received via a USB wireless LAN adaptor. Some access 
points are combined with router or modem functions.

By connecting a computer to the USB [TO HOST] terminal with a USB cable, you can use the instrument as a USB 
audio/MIDI interface for transmitting/receiving MIDI data and audio data between the instrument and the computer. 
Among the various possibilities are being able to play the instrument and record performance data by using the 
computer, or playing music data on the computer and listening to it on the instrument.

NOTICE
• Use an AB type USB cable of less than 3 meters. USB 3.0 cables cannot be used.
• If you are using a DAW (digital audio workstation) application with this instrument, set the Audio Loopback function to off 

(page 49). Otherwise, a loud sound may occur, depending on the settings of the computer.

NOTE
• When using a USB cable to connect the instrument to your computer, make the connections directly without passing through a USB hub.

• The instrument will begin transmission a short time after the USB connection is made.

• Unexpected sounds may occur if you edit MIDI data related to the Grand Expression Modeling effect (page 24) on a computer.

Transmitting/Receiving Audio Data (USB Audio Interface function)

By connecting a computer or a smart device to the USB [TO HOST] terminal via a USB cable, digital audio data can 
be transmitted/received. This USB Audio Interface function provides the following advantages:

• Playing back audio data with high sound quality
This gives you direct, clear sound in which the sound quality has less noise and deterioration than that from the 
[AUX IN] jack.

• Recording performance on the instrument as audio data by using a recording software or 
a music production software
The recorded audio data can be played back on the computer or smart device.

NOTE
• Depending on the model or OS of the computer and smart device, noise may occur, or this function may not be available.

• When transmitting or receiving audio signals by using a computer running Windows, if operation is unstable or delays occur, use the “Yamaha 
Steinberg USB Driver.” On the website below, search for “Yamaha Steinberg USB Driver” and install it on the computer. For instructions on installing 
the driver, refer to the Installation Guide included with the download file. 
https://download.yamaha.com/

Interfacing with a Computer

Instrument

Computer

USB cable

Example

USB terminal

https://download.yamaha.com/
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Turning Audio Loopback on/off

This allows you to set whether audio input sound from the connected computer or smart device is output to a 
computer or a smart device or not along with the performance played on the instrument. To output the audio input 
sound, set the Audio Loopback to “On.” For example, if you want to record the audio input sound as well as the 
sound played on the instrument by using the connected computer or smart device, set this to “On.” If you intend to 
record only the sound played on the instrument by using the computer or smart device, set this to “Off.” 
This is set to “On” by default; however, the setting can be changed via “Utility” > “Audio Loopback” in the System 
menu (page 51).

NOTE
• In this manual, “audio input sound” refers to audio data that is input to the instrument from connected external devices using one of these methods: 

USB Audio Interface function, Bluetooth Audio function (page 43), [AUX IN] jack (page 45) or Wi-Fi (page 47).

• The sound cannot be output to a device connected by Bluetooth or the [AUX IN] jack.

• With Audio recording on this instrument (page 39), the audio input sound from the external device is recorded when this is set to on, while the sound 
is not recorded when this is set to off. However, when the devices are connected via the Bluetooth Audio or [AUX IN] jack, the input sounds are always 
recorded regardless of the Audio Loopback on/off setting.

A USB flash drive can be connected to the USB [TO DEVICE] terminal, allowing you to save data you have recorded 
on the instrument to the USB flash drive (page 39), or play back data contained in the USB flash drive from the 
instrument (page 31). Before using the USB [TO DEVICE] terminal, be sure to read “Using the USB [TO DEVICE] 
terminal” on page 6. 

When a message appears on the display indicating that the USB flash drive has not been formatted, format it from 
“Utility” > “USB Format” in the System menu (page 51).

NOTICE
• Executing the Format operation will delete all data saved in the USB flash drive. Save important data to a computer or another 

storage device.
• When turning off the instrument, make sure that the instrument is NOT accessing the USB flash drive by playback/recording or 

file management (such as during Save, Copy, Delete and Format operations). Failure to do so may corrupt the USB flash drive 
and the data.

NOTE
Although USB devices 2.0 or 3.0 can be used on this instrument, the amount of time for saving to or loading from the USB device may differ depending 
on the type of data or the status of the instrument.

Connecting a USB flash drive

Instrument

USB flash drive
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You can connect speakers to the AUX OUT [L/L+R]/[R] jacks by using audio cables to output the sound played on 
the instrument to the connected devices.

NOTICE
• To avoid possible damage, first turn on the power to the instrument, and then to the external device. When turning off the power, 

first turn off the power to the external device, and then to the instrument. Since this instrument’s power may automatically be 
turned off due to the Auto Power Off function (page 17), turn off the power to the external device, or disable Auto Power Off when 
you do not intend to operate the instrument. 

• Do not route the output from the AUX OUT jacks to the [AUX IN] jack. If you make this connection, the signal input at the [AUX IN] 
jack is output from the AUX OUT jacks. These connections could result in a feedback loop that will make normal performance 
impossible, and may even damage the equipment.

NOTE
• Use only the [L/L+R] jack for connection with a monaural device.

• When you are monitoring the sound output via the AUX OUT jacks from headphones connected to the instrument, we recommend that you turn off 
Binaural from “Sound” > “Binaural” in the System menu (page 51). For details, refer to the Reference Manual.

Outputting the instrument sound to external speakers

A
U

X
 O

U
T

L
/L

+
R

R

Instrument Powered speakers

Phone plug (standard)

Phone plug (standard)

Audio cable

Audio signal

Example
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Making Various Settings in the Menu Display

Pressing the [MENU] button calls up the Menu display. The Menu display contains five menus and allows you to 
make settings related to Voice, Song, Metronome/Rhythm, Recording and System (overall settings for the 
instrument). This section explains the basic operations in the Menu display. For details on each menu, refer to the 
Reference Manual.

For the following, you will need to make additional settings before opening the Menu display.

• When you want to edit Voice-related parameters:
Select a Voice. If you want to edit Voices in Dual/Split/Duo, turn on the desired function. 

• When you want to edit Song-related parameters:
Select a Song.

1. Press the [MENU] button several times to select the desired menu.
Pressing the button repeatedly switches among the menus. The menu name shown at the top of the display 
and the icon at left indicate the selected menu.

2. Use the [u]/[d]/[l]/[r] buttons to select the desired parameter.

3. Use the [l]/[r] buttons to change the setting or execute the operation.
To reset the selected item to the default value on the CLP-885, CLP-875 and CLP-895GP, press and hold the 
[MENU] button until the value is reset. On the CLP-845, CLP-835 and CLP-865GP, press the [l] and [r] 
buttons simultaneously.

4. To exit from the Menu display, press the [EXIT] button.

Voice menu
For making keyboard performance settings (pedal function, volume balance in Dual/Split/Duo, 
transpose, etc.), and for editing Voices.

Song menu
For making Song playback settings (repeat playback, volume, transpose, etc.), for editing 
Songs, and for handling Song files.

Metronome/
Rhythm menu

For adjusting the metronome and rhythm volume, setting the metronome time signature, and 
making rhythm related settings.

Recording menu For making MIDI recording settings.

System menu
For making settings for the entire instrument (tuning, sound, Audio Power Off, display 
brightness, etc.), formatting a USB flash drive, and backing up the instrument settings.

885 875 845 835

41
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Menu name
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Menu icons
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Appendix

The preset Voices that are available differ among the models. The rows of the model names indicate if the model(s) 
have the corresponding preset Voices or not.
: Yes (with Voice Demo)
: Yes (without Voice Demo)
–: No

Voice List

CLP-885
CLP-895GP

CLP-875
CLP-845
CLP-835

CLP-865GP

Voice 
Category

Voice Name Description
Stereo 
Sam-
pling

Touch 
Sensi-
tivity

Key-off 
Sam-
pling

VRM

  PIANO CFX Grand Yamaha’s CFX concert grand piano sound with a 
wide dynamic range for maximum expressive 
control. Suitable for playing in any music genre and 
style. When this Voice is selected, connecting the 
headphones automatically enables binaural 
sampling sound.

   

  Bösendorfer The famed sound of the Vienna-made Bösendorfer 
Imperial concert grand piano. Its spacious sound 
evokes the size of the instrument, and is ideal for 
expressing tenderness in compositions. When this 
Voice is selected, connecting the headphones 
automatically enables binaural sampling sound.

   

  Upright Piano The sound sampled from an upright piano, the 
Yamaha SU7. Enjoy the unique tonal character and 
a lighter, more casual feel.

  – 

 – Studio Grand The sound of Yamaha’s C7 grand piano, which is 
often used in recording studios. Its bright and clear 
sound is good for popular styles.

   

 – Ballad Grand Grand piano sound with a soft and warm tone. 
Good for playing ballads.

   

  Jazz Grand A piano sound with unique tonal character. Good 
for jazz styles.

   

  Rock Grand A bright-sounding piano. Ideal for rock styles.    

  Warm Grand Warm and soft piano sound. Good for relaxing 
music.

   

  Bright Grand Bright piano sound. Good for clear expression and 
“cutting through” other instruments in an ensemble.

   –

  Chill out Piano A heavily processed piano sound with deep reverb. 
Good for relaxing music.

   –

  Lo-Fi Piano A warm piano sound typical of vintage vinyl 
records. Good for styles such as early rock ’n’ roll or 
classic rock.

   –

  HonkyTonk Pf A honky-tonk style piano. Enjoy a tonal character 
that is quite different than a grand piano.

  – 

 – FORTE
PIANO

Scarlatti Piano The sound of a piano made by a musical 
instrument maker in Florence in the early 18th 
century. The maker is famous for inventing the 
piano. It is believed that Scarlatti used the piano 
made by the maker. The sound is bright and 
brilliant.

   –

  Mozart Piano The sound of a piano made by a musical 
instrument maker in Vienna in the late 18th century. 
Mozart and Beethoven played and highly 
appreciated the piano made by this manufacturer. 
Its sound is clear and light.

  – –

: Yes, –: No
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 – FORTE
PIANO

Beethoven 
Piano

The sound of a piano made by a piano 
manufacturer in London in the early 19th century. 
Haydn and Beethoven composed many 
masterpieces inspired by the pianos of this 
manufacturer. It features a rich bass, sparkling 
highs and energetic fortissimo.

   –

  Chopin Piano The sound of a piano made by a piano 
manufacturer in Paris in the 19th century. Chopin 
deeply loved the pianos of this manufacturer, which 
responded well to his sensitive touch. It has a 
sound like a singing voice, sometimes luscious, 
sometimes mournful.

  – –

  E.PIANO Stage E.Piano The sound of an electric piano using hammer-
struck metallic “tines.” Soft tone when played lightly, 
and an aggressive tone when played hard.

–   –

  DX E.Piano An electronic piano sound produced by an FM 
synthesizer. The tone will change as you vary your 
playing touch. Ideal for popular music.

–  – –

  Vintage EP The sound of an electric piano using hammer-
struck metal reeds. Widely used in rock and popular 
music.

–   –

  Soft EP An electric piano with a characteristic panning 
effect. Good for playing quiet ballads.

–   –

  Phaser EP A distinctive phaser effect makes this ideal for 
fusion styles.

–   –

  DX Bright A variation of electronic piano sound produced by 
an FM synthesizer. Its bright and sparkling sound 
character spice up the music.

–  – –

  Tremolo 
Vintage

Includes tremolo ideal for Vintage EP. Frequently 
used in rock music.

–   –

 – ORGAN Organ 
GrandJeu

A registration sound famous for use in French organ 
compositions. This dramatic sound is ideal for 
ending a performance.

 – – –

  Organ 
Principal

This Voice features the combination of pipes 
(8'+4'+2') of a principal (brass instrument) organ. It 
is suitable for Baroque church music.

 – – –

  Organ Tutti This Voice features a full coupler of a pipe organ, 
famous for the sound used in Toccata and Fugue by 
Bach.

 – – –

  Jazz Organ 1 The sound of an electric organ often heard in jazz 
and rock idioms. A slightly brighter sound in which 
the Rotary effect is set to a slow speed.
* You can switch the speed of the Rotary effect between 

slow and fast by pressing the left pedal.

– – – –

  Jazz Organ 2 The sound of an electric organ often heard in jazz 
and rock idioms. The Rotary effect is set to a fast 
speed.
* You can switch the speed of the Rotary effect between 

slow and fast by pressing the left pedal.

– – – –

  Rock Organ Bright and sharp electric organ sound. Optimum for 
rock music.

– – – –

 – Organ Flute 1 A pipe organ sound that combines flute-type 
(woodwind type) stops of different pitches (8' + 4'). 
This is a gentle sound that is ideal for 
accompanying hymns.

 – – –

 – Organ Flute 2 A pipe organ sound that combines flute-type 
(woodwind type) stops of different pitches (8' + 4' + 
1-1/3'). This is brighter than Organ Flute 1, and is 
suitable for solos.

 – – –
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  STRINGS Strings Large-scale strings ensemble with realistic reverb. 
Try combining this Voice with piano in Dual.

  – –

  Slow Strings The sound of a string ensemble, with a slow attack. 
Suitable for use in Dual with piano or electric piano.

  – –

  Choir A big, spacious choir Voice. Perfect for creating rich 
harmonies in slow pieces.


(CLP-
885/
CLP-

895GP 
only)

 – –

  Slow Choir A mellow string ensemble. Enjoy a tonal character 
that is different from a Strings.

 – –

 – Mellow 
Strings

A mellow string ensemble. Enjoy a tonal character 
that is different from a Strings.

  – –

 – Dark Pad Warm and spacious synth sound. Ideal for 
sustained parts in the background of an ensemble, 
or for use in Dual with piano or electric piano.

–  – –

 – Lite Pad Bright and spacious synth sound. Ideal for 
sustained parts in the background of an ensemble, 
or for use in Dual with piano or electric piano.

–  – –

 – Bell Pad Synth sound with a crisp, bell-like sound. Ideal for 
layering in Dual with a piano or electric piano 
sound, but also produces a bright, gorgeous sound 
on its own.

  – –

–  Synth Pad A warm, mellow, and spacious synth sound. Ideal 
for sustained parts in the background of an 
ensemble, or for use in Dual with piano or electric 
piano.

–  – –

  BASS Acoustic Bass The sound of a finger-plucked upright bass. 
Frequently used in jazz and Latin music.

–  – –

  Bass & 
Cymbal

The sound of a cymbal has been layered onto the 
bass. Effective when used for jazz walking-bass 
lines.

–  – –

  Electric Bass The sound of an electric bass. Frequently used in 
jazz, rock, and popular music.

–  – –

  Fretless Bass The sound of a fretless bass. Suitable for styles 
such as jazz and fusion.

–  – –

 – Vintage Bass A different type of electric bass with a soft and 
warm sound.

–  – –

  OTHERS Harpsichord 8' The sound of the instrument frequently used in 
baroque music. Variations in playing touch will not 
affect the volume, and a characteristic sound will be 
heard when you release the key.

 –  –

  Harpsi. 8'+4' A harpsichord with an added upper octave. 
Produces a more brilliant sound.

 –  –

 – Harp This sound was sampled from a grand harp. This 
sound, with a bright attack, is ideal for playing 
gorgeous phrases.

–  – –

  Vibraphone A Vibraphone with spacious and clear sound. Ideal 
for popular music. Pressing the left pedal switches 
Vibrato on and off.

  – –

 – Marimba A marimba sound, sampled in stereo for 
spaciousness and realism.

  – –

 – Celesta The sound of a celesta (a percussion instrument in 
which hammers strike metallic bars to produce 
sound). This instrument is well-known for its 
appearance in “Dance of the Sugar-plum Fairies” 
from Tchaikovsky’s “Nutcracker Suite.”

  – –
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• Key-off Sampling: Samples of the very delicate noises that are produced when keys are released.

• VRM (Virtual Resonance Modeling): Simulated string resonance sound with physical modeling when the damper pedal is pressed or keys are 
pressed. Grand Expression Modeling is effective for VRM Voices. Effects cannot be applied to the VRM Voices.

Voice Demo List
The Voice Demos below are short rearranged excerpts of the original compositions. All other Demo Songs are Yamaha original (© Yamaha 
Corporation).

  OTHERS Nylon Guitar Stereo-sampled, nylon-string guitar with natural 
reality. Suitable for any style of musics.

  – –

  Steel Guitar A bright steel-string guitar sound. Ideal for popular 
music.

–  – –

 – Scat You can enjoy jazz “scatting” with this Voice. 
Depending on how hard and what note range you 
play, different sounds will be produced.

–  – –

 – XG – For details on XG Voices, refer to the “Data List” on 
the website.

–  – –

CLP-885
CLP-895GP

CLP-875
CLP-845
CLP-835

CLP-865GP

Voice 
Category

Voice Name Title Composer

  PIANO CFX Grand Ungarische rhapsodie “Preludio” E-Dur F. Liszt

  Bösendorfer Widmung S.566 R.253 F. Liszt / R. Schumann

  Upright Piano Sonatine F dur Anh.5(2) 1st mov. L. v. Beethoven

 – FORTE
PIANO

Scarlatti Piano Sonata G dur K.14 L.387 G. D. Scarlatti

  Mozart Piano Sontata No.15 C dur K.545 1st mov. W. A. Mozart

 – Beethoven Piano Für Elise a moll L. v. Beethoven

  Chopin Piano Nocturne op.27-2 Des dur F. F. Chopin

  ORGAN Organ Principal Herr Christ, der ein’ge Gottes-Sohn BWV 601 J. S. Bach

  OTHERS Harpsichord 8' Concerto a cembalo obbligato, 2 violini, viola e 
continuo No.7 g moll BWV 1058 1st mov. 

J. S. Bach
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Rhythm List

No. Name

Pops&Rock

1 8Beat

2 16Beat

3 Shuffle1

4 Shuffle2

5 Shuffle3

6 Gospel

7 8BeatBallad

8 6-8SlowRock

Jazz

9 FastJazz

10 SlowJazz

11 Swing

12 JazzWaltz

Latin

13 Samba

14 BossaNova

15 Rumba

16 Salsa

Kids&Holiday

17 KidsPop

18 6-8March

19 ChristmasSwing

20 Christmas3-4
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50 Classics 

Lesson Songs 

*The Lesson Songs are original compositions.

Song List

No. Song Title Composer

Arrangements

1 Canon D dur J. Pachelbel

2 Air On the G String J. S. Bach

3 Jesus, Joy of Man’s Desiring J. S. Bach

4 Twinkle, Twinkle, Little Star Traditional

5 Piano Sonate op.31-2 “Tempest” 3rd mov. L. v. Beethoven

6 Ode to Joy L. v. Beethoven

7 Wiegenlied op.98-2 F. P. Schubert

8 Grande Valse Brillante F. F. Chopin

9 Polonaise op.53 “Héroïque” F. F. Chopin

10 La Campanella F. Liszt

11 Salut d’amour op.12 E. Elgar

12 From the New World A. Dvořák

13 Sicilienne G. U. Fauré

14 Clair de lune C. A. Debussy

15 Jupiter (The Planets) G. Holst

Duets

16 Menuett (Eine kleine Nachtmusik K.525) W. A. Mozart

17 Menuett G dur L. v. Beethoven

18 Marcia alla Turca L. v. Beethoven

19 Piano Concerto No.1 op.11 2nd mov. F. F. Chopin

20 The Nutcracker Medley P. I. Tchaikovsky

Original Compositions

21 Prelude (Wohltemperierte Klavier I No.1) J. S. Bach

22 Menuett G dur BWV Anh.114 J. S. Bach

23 Piano Sonate No.15 K.545 1st mov. W. A. Mozart

24 Turkish March W. A. Mozart

25 Piano Sonate op.13 “Pathétique” 2nd mov. L. v. Beethoven

26 Für Elise L. v. Beethoven

27 Piano Sonate op.27-2 “Mondschein” 1st 
mov.

L. v. Beethoven

28 Impromptu op.90-2 F. P. Schubert

29 Frühlingslied op.62-6 J. L. F. Mendelssohn

30 Fantaisie-Impromptu F. F. Chopin

31 Etude op.10-3 “Chanson de l’adieu” F. F. Chopin

32 Etude op.10-12 “Revolutionary” F. F. Chopin

33 Valse op.64-1 “Petit chien” F. F. Chopin

34 Nocturne op.9-2 F. F. Chopin

35 Nocturne KK4a-16/BI 49 [Posth.] F. F. Chopin

36 Träumerei R. Schumann

37 Barcarolle P. I. Tchaikovsky

38 La prière d’une Vierge T. Badarzewska

39 Liebesträume No.3 F. Liszt

40 Blumenlied G. Lange

41 Humoresque A. Dvořák

42 Arietta E. H. Grieg

43 Tango (España) I. Albéniz

44 The Entertainer S. Joplin

45 Maple Leaf Rag S. Joplin

46 La Fille aux Cheveux de Lin C. A. Debussy

47 Arabesque No.1 C. A. Debussy

48 Cakewalk C. A. Debussy

49 Je te veux E. Satie

50 Gymnopédies No.1 E. Satie

Album Title No./Song Title Composer

Vorschule im 
Klavierspiel op.101

1–106 F. Beyer

25 Etudes faciles et 
progressives op.100

1 La candeur J. F. Burgmüller

2 Arabesque

3 Pastorale

4 Petite réunion

5 Innocence 

6 Progrès

7 Courant limpide

8 La gracieuse 

9 La chasse 

10 Tendre fleur 

11 La bergeronnette

12 Adieu

13 Consolation 

14 La styrienne 

15 Ballade 

16 Douce plainte 

17 Babillarde

18 Inquiétude 

19 Ave Maria 

20 Tarentelle

21 Harmonie des anges

22 Barcarolle 

23 Retour

24 L'hirondelle

25 La chevaleresque

100 Übungsstücke 
op.139

1–100 C. Czerny

30 Etudes de 
mécanisme op.849 

1–30 C. Czerny

The Virtuoso Pianist 1–20 1-Variation. 1–22 C-L. Hanon

About the Duet Songs 
The Songs listed below are Duet Songs.

• Nos. 16-20 of “50 Classics”

• Nos. 1–11 of the Vorschule im Klavierspiel op.101 of “Lesson 
Songs” as well as 32–34, 41–44, 63–64, and 86–87

The “R” (right-hand) part is for the right hand of the first player, the 
“L” (left-hand) part is for the left hand of the first player, and the 
“Extra” part is for both hands of the second player.

No. Song Title Composer
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Certain message displays may remain open. If this happens, press the [EXIT] button to close the message display. 

Message List

Messages Description

Access error The operation has failed. The following causes can be considered. 
• The file operation is wrong. Follow the instructions in the Reference Manual, “File” 

section in the Song menu or the “Backup” section in the System menu.
• The connected USB device is not compatible with this instrument. Use a device whose 

compatibility has been confirmed by Yamaha (page 6).
• The file may be damaged.

Bluetooth pairing... The instrument is standing by for Bluetooth pairing. For details, refer to page 44.

Cannot be executed The following causes can be considered.
• This message appears when you attempt to perform a file operation to a preset Song or 

an Audio Song. For details on the limitations of file operation, refer to the Song menu 
chapter on the Reference Manual. 

• The [PIANO ROOM] button has been pressed while a Voice that doesn’t allow use of 
the Piano Room function has been selected. Select “CFX Grand,” “Bösendorfer” or any 
other PIANO category Voices having VRM effects (page 52) to apply the settings.

Change to Current Tempo The tempo of the selected MIDI Song will be changed to the current tempo and 
overwritten. For details, refer to the Song menu chapter in the Reference Manual.

Change to Current Voice The Voice of the selected MIDI Song will be changed to the current Voice and 
overwritten. For details, refer to the Song menu chapter in the Reference Manual.

Completed The operation is complete. Go on to the next step.

Completed
Restart now

Restore is complete. The instrument will be automatically restarted.

Convert canceled Conversion from MIDI Song to Audio Song is canceled.

Convert completed to USB/
USERFILES/

The MIDI Song has been converted to an Audio Song and saved to the “USER FILES” 
folder in the USB flash drive.

Convert to Audio The MIDI Song is being converted to an Audio Song. 

Copy completed to USB/
USERFILES/

The Song in the “User” location on the instrument has been copied to the “USER FILES” 
folder in the USB flash drive.

Copy completed to User The Song in the USB flash drive has been copied to the “User” location on this 
instrument.

Device busy The operation, such as Audio Song playback/recording or MIDI to Audio conversion, has 
failed. This message appears when you attempt to use a USB flash drive to which 
recording/deleting operations have been repeated. Format the USB flash drive after 
making sure there is no important data in it, and try again. To format the USB flash drive, 
execute “Utility” > “USB Format” in the System menu (page 51).

Device removed The USB flash drive has been removed from the USB [TO DEVICE] terminal.

Duplicate name This message indicates that an identically named file already exists. Rename the file.

Executing Executing the operation. Wait until the message disappears, and then go on to the next 
step.

Factory reset completed
Restart

Factory reset is complete. The instrument will be restarted.

Factory reset executing
Memory Song excluded

The instrument is now being reset to the default settings. The Songs in the “User” 
(page 31) and Bluetooth pairing information (page 44) will not be cleared.
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Incompatible device An incompatible USB device is connected. Use a device whose compatibility has been 
confirmed by Yamaha (page 6).

Internal hardware error A malfunction has occurred in the instrument. Contact your nearest Yamaha dealer or 
authorized distributor.

Last power off invalid
Checking memory

This message appears when the power is turned on after turning off the power while 
handling a Song file or saving a backup file. The internal memory is being checked while 
this message appears. If the internal settings are damaged, they will be reset to the 
default settings. If the Songs in the “User” location are damaged, they will be deleted. 
Wait until the message disappears, and then use the instrument.

Maximum no. of devices exceeded The number of devices exceeds the limitation. Only one USB device can be connected to 
the USB [TO DEVICE] terminal.

Memory full Since the capacity and the number of files in the “User” or the USB flash drive are full, 
the operation cannot be completed. Delete some unnecessary Songs (page 42) and try 
again.

Move completed to USB/
USERFILES/

The Song in the “User” on this instrument has been moved to the “USER FILES” folder in 
the USB flash drive.

Move completed to User The Song in the USB flash drive has been moved to the “User” location on this 
instrument.

No device No USB flash drive has been connected to the USB [TO DEVICE] terminal. Connect a 
USB flash drive, and execute the operation again.

No response from USB device The instrument cannot communicate with the connected USB device. Redo the 
connection. If you still see this message, the USB device may be damaged.

Please wait The instrument is processing the data. Wait until the message disappears, and then go 
on to the next step.

Protected device You are attempting to record or save the data to a write-protected USB flash drive. 
Disable write-protect, if possible, and try again. If you still see this message, the USB 
flash drive is internally protected. You cannot write any data to such a drive.

Read-only file You attempted a file operation to a read-only file. Use a read-only file after disabling the 
read-only setting.

Remaining space on drive is low Since the remaining memory on the “User” drive or USB flash drive is low, delete any 
unnecessary files (page 42) before recording.

Same file name exists This message appears if an identically named file already exists when performing a file 
operation (Copy/Move/MIDI to Audio). Select to overwrite the file or to cancel the 
operation.

Song error A problem has been found with the Song data. Reselect the Song, and try again to play 
back. If the message still appears, the Song data may have been damaged.

Song too large The following causes can be considered.
• The size of the selected Song exceeds the limitation. The limitation for playback is 

approx. 500KB (MIDI), 80 minutes (Audio).
• The Song size reached the limitation during recording. The limitation for recording is 

approx. 500KB (MIDI), 80 minutes (Audio). The recording will end automatically and 
the recorded data before the end is saved.

• The Song size reached the limitation during converting a MIDI Song to an Audio Song. 
The limitation is 80 minutes (Audio).

System limit This message appears when the number of files and folders exceeds the system limit. 
The maximum number of files and folders which can be saved in a folder is 250. Try 
again after deleting/moving the unnecessary file(s).

This data format is not supported The format of the selected Song is not compatible with this instrument. For information 
on Songs that can be played on this instrument, refer to page 30.

Messages Description
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Unformatted device The USB flash drive is not formatted. Format it from “Utility” > “USB Format” in the 
System menu (page 51).

Unsupported device An unsupported USB device is connected. Use a device whose compatibility has been 
confirmed by Yamaha (page 6).

USB device overcurrent error Communication with the USB device has been cut off because of an abnormal power 
surge to the device. Disconnect the USB device from the USB [TO DEVICE] terminal and 
turn the power off and on again.

USB hub cannot be used Connect a USB device directly to the instrument without using a USB hub.

USB power consumption 
exceeded

The power consumption of the connected USB device has exceeded the limit. Use a 
device whose compatibility has been confirmed by Yamaha (page 6).

Wrong device The file operation cannot be made to the connected USB flash drive. The following 
causes can be considered.
• The USB flash drive is not formatted. Format it from “Utility” > “USB Format” in the 

System menu (page 51). 
• The number of files exceeds the system limit. The maximum number of files and folders 

which can be saved in a folder is 250. Try again after deleting/moving the unnecessary 
file(s).

Wrong name This message appears during renaming a Song file because of the following causes. 
Rename the Song correctly. For details, refer to “File” section in the Song menu on the 
Reference Manual. 
• No character has been input.
• You used a period or space at the beginning/ending of a Song name.

Messages Description
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When a message is displayed, refer to the “Message List” (page 58) for troubleshooting aid.
For details on the settings in the Menu display (page 51), refer to the Reference Manual.

Troubleshooting

Problem Possible Cause and Solution

The instrument does not turn on. The instrument has not been plugged in properly. Securely connect the AC adaptor to 
the DC IN jack on the instrument and to the AC outlet (page 16).

The power is automatically turned 
off.

This is normal and due to the Auto Power Off function. If necessary, disable the Auto 
Power Off function (page 17).

Mechanical noise is heard during 
performance.

The keyboard mechanism of this instrument simulates the keyboard mechanism of an 
actual piano. Mechanical noise is also heard on a piano.

Noise is heard from the 
instrument’s speakers.

Noise may be heard if a mobile phone is used near the instrument or if the phone is 
ringing. Turn off the mobile phone, or use it further away from the instrument.

Noise is heard from the 
instrument’s speakers or 
headphones when using the 
instrument with the smart device.

When you use the instrument along with the app on your smart device, we recommend 
that you enable “Airplane Mode” on the device to avoid noise caused by communication. 
When wirelessly connecting a smart device with this product, make sure that the Wi-Fi or 
Bluetooth setting on the device is turned on.

The overall volume is low, or no 
sound is heard.

• The master volume may be set too low. Set it to an appropriate level with the 
[VOLUME] slider (page 18).

• The Volume Limiter function is set to “On.” Set Volume Limiter to “Off” from “Sound” > 
“Volume Limiter” in the System menu (page 51).

• The volume level for the keyboard performance is set too low. Adjust the balance to 
increase the keyboard volume from “Volume” > “Song - Keyboard” in the Song menu 
(page 51). 

• Headphones are connected. Disconnect the headphone plugs and the adaptor plugs.
• The Speaker setting is “Off.” Set the Speaker to “Normal” or “On” from “Utility” > 

“Speaker” in the System menu (page 51).
• Local Control is “Off.” Set Local Control to “On” from “MIDI” > “Local Control” in the 

System menu (page 51).

The speakers do not switch off 
when a pair of headphones is 
connected to the [PHONES] jack.

The Speaker setting is “On.” Set the speaker setting to “Normal” from “Utility” > “Speaker” 
in the System menu (page 51).

Pedals do not function. The pedal cord may not be securely connected to the [PEDAL] connector. Be sure to 
insert the pedal cord all the way until the metal part of the cord plug disappears from 
view (page 19).

The keyboard volume is lower than 
the Song playback volume.

The volume level for the keyboard performance is set too low. Adjust the balance to 
increase the keyboard volume from “Volume” > “Song - Keyboard” in the Song menu 
(page 51). 

The buttons do not respond. • While a function is being used, some buttons unrelated to the function may be disabled. 
If a Song is playing, stop playback. If in another situation, press the [EXIT] button to 
return to the Voice or Song display, and then perform the desired operation.

• While Smart Pianist is connected to the instrument, no operation can be performed on 
the instrument. Control the instrument by using Smart Pianist. To disconnect Smart 
Pianist, press the [EXIT] button.

The pitch and/or tone of the piano 
Voices in certain ranges do not 
sound right.

This is normal and not a malfunction. The piano Voice was designed to reproduce the 
original sound of the piano as much as possible. As a result, the harmonics may be more 
pronounced in certain tonal ranges, which could make the pitch or range of the sound 
seem a bit unusual.

Higher or lower notes do not sound 
correctly when the transpose or 
octave setting is made.

This instrument can cover the range of C -2 – G8 when you set the transposition or 
octave. If notes lower than C-2 are played, the sound is moved one octave higher. If 
notes higher than G8 are played, the sound is moved one octave lower.
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* Depending on the country in which you purchased the product, the instrument may not have Bluetooth capability. For information on whether Bluetooth 
functionality is included or not, refer to page 21.

For more information, check the “Frequently Asked Questions (FAQ)” on the following website:

https://faq.yamaha.com/s/

* Available in English, German, French, Spanish and some other languages. 

Performance in Dual/Split/Duo is 
not recorded, or part data is lost 
unexpectedly.

Switching to Dual/Split/Duo in the middle of the Song cannot be recorded. Also, the 
recording part for the Voice 2 (Dual) or the left Voice (Split/Duo) is automatically assigned 
(page 41). If the assigned part already has data, the data will be overwritten and deleted 
when you record.

The keyboard sound in Duo may 
be output from only one speaker.

This is because the default pan setting differs depending on the Voice. Set “Duo Type” to 
“Balanced” in the System menu (page 51), or change the “Pan” setting from “Voice Edit” 
in the Voice menu (page 51).

The Song title is not correct. The “Language” setting may be different than the one selected when the Song was 
named. Also, if the Song was recorded on another instrument, the title might be 
displayed incorrectly. Change the setting of “Utility” > “Language” > “Song” in the System 
menu (page 51). However, if the Song was recorded on another instrument, changing 
the “Language” setting may not resolve the problem.

Menu display cannot be called up. When Song is being played back, Menu display other than Voice menu and Song menu 
will not appear. Also, while recording, only the Recording menu appears. Stop Song 
playback or recording before calling up your desired menu.

Rhythm does not start. Synchro Start function has been turned on, meaning you need to press a key to start 
playback. To start playback by pressing the [RHYTHM] button, set “SynchStart” off in the 
Metronome/Rhythm menu (page 51).

Metronome, MIDI Song or Rhythm 
goes out of tempo slightly when 
you play the keyboard.

This occurs infrequently when Grand Expression Modeling is set to “Dynamic.” If this 
happens, set Grand Expression Modeling to “Static” (page 24).

The contents of the Wireless LAN 
is not shown in the display even 
though the USB wireless LAN 
adaptor is connected.

Disconnect the USB wireless LAN adaptor and connect it again.

The Bluetooth-equipped audio 
player cannot be paired with nor 
connected to the instrument.

Check that the Bluetooth function of the audio player is activated. To connect the audio 
player and the instrument via Bluetooth, both devices need to be functional.

The audio player and the instrument need to be paired to connect with each other via 
Bluetooth (page 43).

In case there is a device (microwave oven, wireless LAN device, etc.) that outputs 
signals in the 2.4 GHz frequency band nearby, move this instrument away from the 
device that is emitting radio-frequency signals.

Problem Possible Cause and Solution

https://faq.yamaha.com/s/
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Assembly Precautions

CAUTION
• (CLP-885, CLP-875, CLP-845, CLP-835) Assembly should be 

carried out by at least two persons.
• (CLP-895GP, CLP-865GP) Assembly should be carried out 

by at least four persons.
• Assemble the unit on a hard and flat floor with ample space.
• Be sure to use the correct parts in the correct orientation, 

and assemble the instrument in accordance with the 
sequence given here.

• Keep small parts (such as screws) out of the reach of 
infants. Children may accidentally swallow them.

• Be sure to use only the included screws of the specified 
sizes. Do not use any other screws. Use of incorrect screws 
can cause damage or malfunction of the product.

• Be sure to tighten all screws upon completing assembly of 
the unit.

• When moving and placing the instrument after assembly, 
check “When moving and placing the instrument” on 
page 8.

• To disassemble the unit, reverse the assembly sequence 
given below. Failure to do so can result in damage to the 
instrument or personal injury.

Assembling the Clavinova

CLP-885 Assembly

Remove all parts from the package and make sure you 
have all of the items.

The power cord and AC adaptor may not be included, or may look different 
from the illustration above, depending on your particular area. Please check 
with your Yamaha dealer.

Assembling the Clavinova

Have a Phillips-head (+) screwdriver of the appropriate size 
ready.

Reference page

CLP-885 page 63

CLP-875 page 67

CLP-845 page 69

CLP-835 page 69

CLP-895GP page 71

CLP-865GP page 75

Post-assembly checklist
 There are no unused parts.

 The instrument is stable even if you shake it.

 Both the pedal cord and power cord are plugged 
securely into the correct jacks.

 If any of the above items have not been confirmed, 
review the assembly procedure and correct any 
errors. 

CAUTION
If the unit creaks or is otherwise unsteady when you play 
on the keyboard, refer to the assembly diagrams and 
retighten all screws.

Foamed styrol pads
Remove foamed styrol pads from the package, position them 
on the floor, then place A on top of them. Position the pads so 
that they will not hide the connector panel on the bottom of A.

Connector
panel

The pedals are covered with vinyl covers when 
shipped from the factory. Before starting the 
assembly, please make sure to remove the 
cover from the damper pedal.

6 × 20 mm round head screws × 4

6 × 20 mm flat head screws × 10

4 × 14 mm round head screws × 10 Power cord

Cord holders × 2

4 × 10 mm thin screws × 2

AC adaptor

Headphone 
hanger

* See page 18 for instructions on
attaching the hanger.
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1. Attach E and F to D.

1-1. Remove the twist tie from the folded pedal 
cord.
Don’t discard the twist tie, you’ll need it later in 
step 6.

1-2. While pushing the lower part of E and F 
from the outside, secure D using four 
6 × 20 mm round head screws.

2. Attach B.

2-1. Insert B between E and F as shown in the 
illustration, and then hold B at a position of 
5 cm away from D.

2-2. Lower B slowly, and then hook the screws 
on the right and left sides of B onto the 
notches of brackets on E and F.

2-3. Temporarily secure the center with two 
4 × 14 mm round head screws.

2-4. Temporarily secure the surroundings with 
four 6 × 20 mm flat head screws.

3. Mount A.
Be sure to place your hands at least 15 cm away 
from either end of the main unit when positioning it.

CAUTION
• Be extra careful not to drop the main unit or let your fingers 

be pinched by it.
• Do not hold the main unit in any position other than the 

position specified above.

1-2

1-1

2-1
2-1

2-2

2-2

Proper way to hold B

2-4

2-3

Align the screw holes.

At least 15 cm
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4. Attach A.

4-1. Adjust the position of A so that the left and 
right ends of A will project beyond E and F 
equally (as seen from the rear).

4-2. Secure A using four 6 × 20 mm flat head 
screws from the front.

4-3. Secure A using two 6 × 20 mm flat head 
screws from the rear.

4-4. Firmly tighten the screws from the upper 
parts you temporarily fastened in previous 
step 2-3 and 2-4 above (assembly B).

5. Connect the speaker cord.
Insert the speaker cord plug into the connector so 
that the tab extends toward the front when viewed 
from the rear.

6. Insert the DC plug of the AC adaptor 
into the DC IN jack.

6-1. Insert the pedal cord plug into the [PEDAL] 
connector.

6-2. Attach the cord holders to the instrument, 
then clip the cord into the holders. At this 
time, be careful that the pedal cord isn’t 
loose between the plug and cord holder.

6-3. Use a twist tie to bundle the pedal cord.

4-3

4-2

4-1

4-4
Insert the pedal cord securely in 
the proper direction until the 
metal part of the plug 
disappears from view. 
Otherwise, the pedal may not 
function properly. 

6-2

6-1

6-3
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6-4. Connect one end of the power cord to the 
AC adaptor.

6-5. Insert the DC plug of the AC adaptor into 
the DC IN jack.

7. Attach C (two pieces).
Secure the two C pieces with eight 4 × 14 mm round 
head screws.

8. Attach G and H.
Attach G to the front, and H to the rear by pressing 
them against the instrument.

6-5

After completing assembly, confirm the checklist on 
page 63.
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CLP-875 Assembly

Remove all parts from the package and make sure you 
have all of the items.

The power cord and AC adaptor may not be included, or may look different 
from the illustration above, depending on your particular area. Please check 
with your Yamaha dealer.

1. Attach C to D and E. 

1-1. Untie and straighten out the bundled pedal 
cord. Do not discard the vinyl tie. You will 
need it later in step 5.

1-2. Insert the protrusions into the holes on the 
brackets, then attach D and E to C by 
tightening the four thick screws 
(6 × 20 mm).

2. Attach B.
Depending on the model of digital piano you 
purchased, the surface color of one side of B may be 
different from the other side. If so, position B so that 
the side similar in color to D and E faces the player. 

2-1. Align the screw holes on the upper side of 
B with the bracket holes on D and E, then 
attach the upper corners of B to D and E by 
finger-tightening two thin screws 
(4 × 12 mm).

2-2. Secure the bottom end of B using four 
tapping screws (4 × 20 mm).

2-3. Securely tighten the screws on the top of B 
that were attached in step 2-1.

A

B

C

D E

Foamed styrol pads
Remove foamed styrol pads from the package, position them on 
the floor, then place A on top of them. Position the pads so that 
they will not block the connector panel and the speaker box on the 
bottom of A.

Bundled pedal cord 
inside The pedals are covered with vinyl 

covers when shipped from the factory. 
Before starting the assembly, please 
make sure to remove the cover from 
the damper pedal.

Connector panel

6 × 20 mm thick screws × 10

4 × 12 mm thin screws × 2

4 × 20 mm tapping screws × 4 Power cord

Cord holders × 2

4 × 10 mm thin screws × 2

Headphone 
hanger

AC adaptor

* See page 18 for instructions on
attaching the hanger.

1-2

1-1

1-2

1-2

2-1, 2-3

2-2

D

B
E
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3. Mount A.
Be sure to place your hands at least 15 cm away 
from either end of the main unit when positioning it. 

CAUTION
• Be extra careful not to drop the main unit or let your fingers 

be pinched by it.
• Do not hold the main unit in any position other than the 

position specified above.

4. Secure A. 

4-1. Adjust the position of A so that the left and 
right ends of A will project beyond D and E 
equally (as seen from the front).

4-2. Secure A by tightening six thick screws 
(6 × 20 mm) from the front.

5. Connect the pedal cord and AC 
adaptor. 

5-1. Insert the plug of the pedal cord into the 
[PEDAL] connector.

5-2. Attach the cord holders to the rear panel as 
shown, then clip the cord into the holders.

5-3. Use a vinyl tie to take up any slack in the 
pedal cord.

5-4. Connect one end of the power cord to the 
AC adaptor.

5-5. Insert the DC plug of the AC adaptor into 
the DC IN jack.

AA

At least 15 cm

Align the screw holes.

4-1

4-2

AA

AA

Insert the pedal cord securely in 
the proper direction until the 
metal part of the plug 
disappears from view. 
Otherwise, the pedal may not 
function properly. 

After completing assembly, confirm the checklist on 
page 63.

5-15-1

5-3

5-2
5-5
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CLP-845, CLP-835 Assembly

Remove all parts from the package and make sure you 
have all of the items.

The power cord and AC adaptor may not be included, or may look different 
from the illustration above, depending on your particular area. Please check 
with your Yamaha dealer.

1. Attach C to D and E. 

1-1. Untie and straighten out the bundled pedal 
cord. Do not discard the vinyl tie. You will 
need it later in step 5.

1-2. Insert the protrusions into the holes on the 
brackets, then attach D and E to C by 
tightening the four thick screws 
(6 × 20 mm).

2. Attach B.
Depending on the model of digital piano you 
purchased, the surface color of one side of B may be 
different from the other side. If so, position B so that 
the side similar in color to D and E faces the player. 

2-1. Align the screw holes on the upper side of 
B with the bracket holes on D and E, then 
attach the upper corners of B to D and E by 
finger-tightening two thin screws 
(4 × 12 mm).

2-2. Secure the bottom end of B using four 
tapping screws (4 × 20 mm).

2-3. Securely tighten the screws on the top of B 
that were attached in step 2-1.

Foamed styrol pads
Remove foamed styrol pads from the package, position them on 
the floor, then place A on top of them. Position the pads so that 
they will not block the connector panel and the speaker box on the 
bottom of A.

Bundled pedal cord 
inside The pedals are covered with vinyl 

covers when shipped from the factory. 
Before starting the assembly, please 
make sure to remove the cover from 
the damper pedal.

Connector panel

6 × 20 mm thick screws × 10

4 × 12 mm thin screws × 2

4 × 20 mm tapping screws × 4 Power cord

Cord holders × 2

4 × 10 mm thin screws × 2
Headphone 
hanger

AC adaptor

* See page 18 for instructions on
attaching the hanger.

1-2

1-2

1-2

1-1

2-1, 2-3

2-2
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3. Mount A.
Be sure to place your hands at least 15 cm away 
from either end of the main unit when positioning it.

CAUTION
• Be extra careful not to drop the main unit or let your fingers 

be pinched by it.
• Do not hold the main unit in any position other than the 

position specified above.

4. Secure A.

4-1. Adjust the position of A so that the left and 
right ends of A will project beyond D and E 
equally (as seen from the front).

4-2. Secure A by tightening six thick screws 
(6 × 20 mm) from the front.

5. Connect the pedal cord and AC 
adaptor. 

5-1. Insert the plug of the pedal cord into the 
[PEDAL] connector.

5-2. Attach the cord holders to the rear panel as 
shown, then clip the cord into the holders.

5-3. Use a vinyl tie to take up any slack in the 
pedal cord.

5-4. Connect one end of the power cord to the 
AC adaptor.

5-5. Insert the DC plug of the AC adaptor into 
the DC IN jack.

A

At least 15 cm

Align the screw holes.

A4-1

4-2

Insert the pedal cord securely in 
the proper direction until the 
metal part of the plug 
disappears from view. 
Otherwise, the pedal may not 
function properly. 

After completing assembly, confirm the checklist on 
page 63.

5-1

5-3

5-2

5-5
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CLP-895GP Assembly

Remove all parts from the package and make sure you 
have all of the items.

Main unit
To prevent damage to the connector panels located at the bottom of main unit, 
make sure to place main unit on the Styrofoam pads. Also, make sure that the 
pads do not touch the connector panels. 

The power cord and AC adaptor may not be included, or may look different 
from the illustration above, depending on your particular area. Please check 
with your Yamaha dealer.

1. Lean the main unit against the wall as 
shown below.

CAUTION
Be careful not to pinch your fingers. 

1-1. Spread a large soft cloth, such as a blanket, 
as shown to protect the floor and wall 
surfaces.

1-2. Lean the main unit against the wall with the 
key cover closed and the keyboard side on 
the bottom.Pedal box

Pads

Cord holder

Power cord

Bundled pedal cord inside.
The pedals are covered with 
vinyl covers when shipped from 
the factory. Remove the cover 
from damper pedal for optimum 
use of the GP Responsive 
Damper Pedal effect.

Legs

Leg beams

Lyre braces

6 × 20 mm fixing screws 
(4 pcs.)

6 × 40 mm fixing screws 
(12 pcs.)

4 × 16 mm thin screws 
(4 pcs.)

4 × 10 mm thin screws 
(12 pcs.)

Connector panel

AC adaptor

4 × 10 mm thin screws 
(4 pcs.)

Adaptor holders

Headphone 
hanger

4 × 10 mm thin screws 
(2 pcs.)

* See page 18 for instructions on attaching the hanger.

Be sure to position the 
keyboard side on the bottom.

Incorrect

NOTICE
Do not place the main unit as shown in the illustration 
here.

Incorrect

Incorrect
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2. Attach the three legs and three leg 
beams.
Refer to the diagram below to verify the orientation 
of the legs.

2-1. Install and tighten four screws on each leg, 
starting with one of the front legs.

2-2. Install and tighten four screws on each leg, 
starting with one of the front legs.

2-3. Slide the leg beams over the legs, and 
attach them to each of the legs using four 
thin screws (4 × 10 mm).
Make sure that the gradually inclined side of the leg 
beams faces the inside of the unit as shown.

3. Attach the lyre braces.

3-1. Attach the lyre braces using the four thin 
screws (4 × 16 mm).

4. Raise the unit to the standing position.
Use the front legs as support to raise the unit.

Rear leg

Front leg Front leg

6 × 40 mm fixing screws

4 × 10 mm 
thin screws

The gradually 
inclined side faces 
the inside.

3-1

4 × 16 mm 
thin screws
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5. Install the pedal box.

5-1. Remove the twist tie and tape that affix the 
pedal cord to the upper portion of the pedal 
box.

5-2. Attach the front side of the pedal box to the 
bottom of the unit by finger-tightening the 
two fixing screws (6 × 20 mm).

5-3. Insert the lyre braces into the pedal box 
recesses and make sure they fit securely.

5-4. Align the cord with the groove on the unit 
and attach the backside of the pedal box 
using the two fixing screws (6 × 20 mm), 
and then securely tighten the two screws of 
the front side of the pedal box that were 
attached in step 5-2.

5-5. Loosen the four screws that were attached 
in step 3, and then securely tighten the four 
screws again while pushing the lyre braces 
in the direction of arrows as illustrated.

Tape Twist tie

6 × 20 mm 
fixing screws

6 × 20 mm fixing screws
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5-6. Insert the pedal cord plug into the [PEDAL] 
connector. Insert the plug so the arrow side 
faces front (toward the keyboard).
If the plug will not go in easily, do not force it. 
Double-check the orientation of the plug, then try 
again.

5-7. Attach the cord holder to the bottom of the 
main unit as shown, then clip the holder 
around the cord.

6. Connect the AC adaptor.

6-1. Connect one end of the power cord to the 
AC adaptor.

6-2. Insert the DC plug of the AC adaptor into 
the DC IN jack.

7. If desired, you can attach the AC 
adaptor to the bottom of the unit by 
using the adaptor holders.
For specific instructions, refer to the leaflet enclosed 
with the adaptor holders. 

CAUTION
To disassemble the unit, reverse the assembly sequence. 
Failure to do so can result in damage to the instrument or 
personal injury. In particular, if you lay down the main unit 
without detaching the pedal box, the pedals will break.

5-7

5-6

Insert the pedal cord securely in the proper 
direction until the metal part of the plug 
disappears from view. Otherwise, the pedal 
may not function properly.

After completing assembly, confirm the checklist on 
page 63.

AC adaptor

4 × 10 mm 
thin screws
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CLP-865GP Assembly

Remove all parts from the package and make sure you 
have all of the items.

The power cord and AC adaptor may not be included, or may look different 
from the illustration above, depending on your particular area. Please check 
with your Yamaha dealer.

1. Lean the unit against the wall as 
shown below.

CAUTION
Be careful not to pinch your fingers.

1-1. Spread a large soft cloth, such as a blanket, 
as shown to protect the floor and wall 
surfaces.

1-2. Lean the main unit against the wall with the 
key cover closed and the keyboard side on 
the bottom.

Legs Pedal box

6 × 40 mm fixing screws × 12

Cord holder

6 × 20 mm fixing screws × 4

Power cord

Bundled pedal cord inside.
The pedals are covered with 
vinyl covers when shipped from 
the factory. Before starting the 
assembly, please make sure to 
remove the cover from the 
damper pedal.

Connector panel

Main unit
To prevent damage to the connector panels located at the bottom of main 
unit, make sure to place main unit on the Styrofoam pads. Also, make sure 
that the pads do not touch the connector panels.

Headphone 
hanger 4 × 10 mm thin screws × 2

AC adaptor

4 × 10 mm thin screws × 4
Adaptor holders

Pads

* See page 18 for instructions on attaching the hanger.

Be sure to position the 
keyboard side on the bottom.

Incorrect

NOTICE
Do not place the main unit as shown in the illustration 
here.

Incorrect

Incorrect
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2. Attach two front legs and a rear leg.
Refer to the diagram below to verify the orientation 
of the legs.

2-1. Install and tighten four screws on each leg, 
starting with one of the front legs.

3. Install the pedal box.

3-1. Remove the twist tie that affixes the pedal 
cord to the upper portion of the pedal box.

3-2. Align the cord with the groove on the unit, 
and attach the pedal box using four 
screws.

3-3. Insert the pedal cord plug into the [PEDAL] 
connector. Insert the plug so the arrow side 
faces front (toward the keyboard). If the 
plug will not go in easily, do not force it. 
Double-check the orientation of the plug, 
then try again.

3-4. Attach the cord holder to the bottom of the 
main unit as shown, then clip the holder 
around the cord.

Rear leg

Front leg Front leg

6 × 40 mm fixing screws

Twist tieTape

6 × 20 mm fixing screws

3-3

3-4

Insert the pedal cord securely in the proper 
direction until the metal part of the plug 
disappears from view. Otherwise, the pedal 
may not function properly.
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4. Raise the unit to the standing position.
Use the front legs as support to raise the unit.

CAUTION
Be careful not to pinch your fingers. When you raise the unit, 
do not hold the key cover.

5. Connect the AC adaptor.

5-1. Connect one end of the power cord to the 
AC adaptor.

5-2. Insert the DC plug of the AC adaptor into 
the DC IN jack.

6. If desired, you can attach the AC 
adaptor to the bottom of the unit by 
using the adaptor holders.
For specific instructions, refer to the leaflet enclosed 
with the adaptor holders. 

CAUTION
To disassemble the unit, reverse the assembly sequence. 
Failure to do so can result in damage to the instrument or 
personal injury. In particular, if you lay down the main unit 
without detaching the pedal box, the pedals will break.

After completing assembly, confirm the checklist on 
page 63.

AC adaptor

4 × 10 mm 
thin screws
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Specifications (CLP-885, CLP-875, CLP-845, CLP-835)
Refer to page 81 for specifications of the CLP-895GP and CLP-865GP. 

Specifications

CLP-885 CLP-875 CLP-845 CLP-835

Product Name Digital Piano

Size/Weight

Width
[For models with polished finish]

1,461 mm (57-1/2")
[1,467 mm (57-3/4")]

1,450 mm (57-1/16")
[1,455 mm (57-5/16")]

Height
[For models with 
polished finish]

With music rest closed
1,027 mm (40-7/16")
[1,029 mm (40-1/2")]

967 mm (38-1/16")
[970 mm (38-3/16")]

927 mm (36-1/2")
[930 mm (36-5/8")]

With music rest raised
1,130 mm (44-1/2")
[1,131 mm (44-1/2")]

1,091 mm (42-15/16")
[1,092 mm (43-0")]

1,083 mm (42-5/8")
[1,084 mm (42-11/16")]

Depth
[For models with polished finish]

494 mm (19-7/16")
[494 mm (19-7/16")]

465 mm (18-5/16")
[465 mm (18-5/16")]

460 mm (18-1/8")
[460 mm (18-1/8")]

Weight
[For models with polished finish]

87 kg (191 lb, 13 oz)
[90 kg (198 lb, 7 oz)]

71 kg (156 lb, 8 oz)
[74 kg (163 lb, 2 oz)]

60 kg (132 lb, 4 oz)
[63 kg (138 lb, 14 oz)]

57 kg (125 lb, 11 oz)
[60 kg (132 lb, 4 oz)]

Control 
Interface

Keyboard

Number of Keys 88

Type
GrandTouch Keyboard: wooden keys (white 
only), synthetic ebony and ivory key tops, 

escapement

GrandTouch-S 
Keyboard: wooden 
keys (white only), 

synthetic ebony and 
ivory key tops, 
escapement

GrandTouch-S 
Keyboard: synthetic 
ebony and ivory key 
tops, escapement

Touch Sensitivity Hard2, Hard1, Medium, Soft1, Soft2, Fixed

88-key Linear Graded 
Hammers

Yes –

Counterweight Yes –

Pedal

Number of Pedals 3: Damper (with Half-pedal function), Sostenuto, Soft

GrandTouch Pedals Yes (with GP Response Damper) Yes

Assignable Functions
Sustain (Switch), Sustain Continuously, Sostenuto, Soft, Pitch Bend Up, Pitch Bend Down, 

Rotary Speed, Vibe Rotor, Song Play/Pause

Display
Type Full Dots LCD

Language English, Japanese

Panel
Type Touch sensors Buttons

Language English

Cabinet
Key Cover Style Folding Sliding

Music Rest Yes (with music braces)

Voices

Tone Generator

Piano Sound Yamaha CFX, Bösendorfer Imperial

Binaural Sampling Yes (“CFX Grand” and “Bösendorfer” only)

VRM (Virtual 
Resonance Modeling)

Yes

Grand Expression 
Modeling

Yes

Polyphony (max.) 256

Preset Number of Voices
53 Voices + 480 XG 
Voices + 14 Drum/

SFX Kits
38 Voices

Compatibility
XG (GM), GS (for 

Song playback), GM2 
(for Song playback)

–

Effects Types

Reverb 7 types

Chorus 3 types

Brilliance 7 types + User

Insertion Effect 12 types

Intelligent Acoustic 
Control (IAC)

Yes

Stereophonic 
Optimizer

Yes
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Effects Functions

Dual Yes

Split Yes

Duo Yes

Songs 

Preset
Number of Preset 
Songs

27 Voice Demo + 
50 Classics + 

303 Lesson Songs
23 Voice Demo + 50 Classics + 303 Lesson Songs

MIDI Recording

Number of Songs 250

Number of Tracks 16

Data Capacity Approx. 500 KB/Song (approx. 22,000 notes)

Audio Recording 
(USB flash drive)

Recording Time (max.) 80 minutes/Song

Compatible Data 
Format

Playback SMF (Format 0, Format 1), WAV (44.1 kHz, 16-bit, stereo)

Recording SMF (Format 0), WAV (44.1 kHz, 16-bit, stereo)

Functions

Piano Room Yes

Rhythm Number of Rhythms 20

Overall Controls

Metronome Yes

Tempo Range 5 – 500

Transpose −12 – 0 – +12

Tuning 414.8 – 440.0 – 466.8 Hz (approx. 0.2 Hz increments)

Scale Type 7 types

USB Audio Interface 44.1 kHz, 24-bit, stereo

Bluetooth
(May not have 
this functionality 
depending on 
the country in 
which you 
purchased the 
product.)

Audio Supported profile: A2DP, Compatible codec: SBC

MIDI Comply with Bluetooth Low Energy MIDI Specification

Bluetooth version 5.0 

Wireless output Bluetooth Class 2

Maximum 
communication 
distance

Approx. 10 m

Radio Frequency 2,401 – 2,481 MHz

Maximum output power 
(EIRP)

4 dBm

Type of modulation GFSK

Storage and 
Connectivity

Storage
Internal Memory Approx. 1.4 MB

External Drives  USB flash drive

Connectivity

Headphones Standard stereo phone jack (× 2)

AUX IN Stereo mini jack

AUX OUT Standard phone jack (L/L+R, R)

USB TO DEVICE Type A

USB TO HOST Type B

DC IN 24 V 16 V

Amplifiers 
and Speakers

Amplifiers
(45 W + 30 W + 40 W) 

× 2
(45 W + 25 W + 40 W) 

× 2
(45 W + 45 W) × 2 30 W × 2

Speakers

(16 cm with diffuser + 
8 cm with diffuser + 
2.5 cm (dome) with 
Bidirectional Horn) 
× 2, Spruce Cone 

Speaker

(16 cm + 8 cm with 
diffuser + 2.5 cm 

(dome) with 
Bidirectional Horn) × 2

(16 cm with diffuser + 
8 cm with diffuser) × 2

16 cm with diffuser × 2

Power 
Supply

AC Adaptor PA-500 PA-300C

Output DC 24 V, 2.5 A DC 16 V, 2.4 A

Polarity

Power Consumption
55 W

(When using PA-500 
AC adaptor)

55 W
(When using PA-500 

AC adaptor)

30 W
(When using PA-500 

AC adaptor)

18 W
(When using PA-300C 

AC adaptor)

CLP-885 CLP-875 CLP-845 CLP-835
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The contents of this manual apply to the latest specifications as of the publishing date. To obtain the latest manual, access the Yamaha website then 
download the manual file. Since specifications, equipment or separately sold accessories may not be the same in every locale, please check with your 
Yamaha dealer.

Included Accessories

• Owner’s Manual
• “50 Classical Music Masterpieces” Music Book
• Online Member Product Registration
• Bench*
• Power cord*, AC adaptor*: (CLP-885/CLP-875/CLP-845) PA-500, (CLP-835) PA-300C

*May not be included depending on your area. Check with your Yamaha dealer.

Separately Sold Accessories
(May not be available depending on your area.)

• Headphones: HPH-150, HPH-100, HPH-50
• Pedal unit: FC35
• AC adaptor: (CLP-885/CLP-875/CLP-845) PA-500, (CLP-835) PA-300C
• USB wireless LAN adaptor: UD-WL01

CLP-885 CLP-875 CLP-845 CLP-835
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Specifications (CLP-895GP, CLP-865GP)
Refer to page 78 for specifications of the CLP-885, CLP-875, CLP-845 and CLP-835. 

CLP-895GP CLP-865GP

Product Name Digital Piano

Size/Weight

Width 1,430 mm (56-5/16")

Height
With music rest closed 932 mm (36-11/16")

With music rest raised 1,094 mm (43-1/16")

Height with lid up 1,577 mm (62-1/16") 1,400 mm (55-1/8")

Depth 1,237 mm (48-11/16") 1,146 mm (45-1/8")

Weight 135 kg (297 lb, 10 oz) 106 kg (233 lb, 11 oz)

Control 
Interface

Keyboard

Number of Keys 88

Type
GrandTouch Keyboard: wooden keys (white 
only), synthetic ebony and ivory key tops, 

escapement

GrandTouch-S Keyboard: synthetic ebony and 
ivory key tops, escapement

Touch Sensitivity Hard2, Hard1, Medium, Soft1, Soft2, Fixed

88-key Linear Graded 
Hammers

Yes –

Counterweight Yes –

Pedal

Number of Pedals 3: Damper (with Half-pedal function), Sostenuto, Soft

GrandTouch Pedals Yes (with GP Response Damper) Yes

Assignable Functions
Sustain (Switch), Sustain Continuously, Sostenuto, Soft, Pitch Bend Up, Pitch Bend Down, 

Rotary Speed, Vibe Rotor, Song Play/Pause

Display
Type Full Dots LCD

Language English, Japanese

Panel
Type Touch sensors Buttons

Language English

Cabinet
Key Cover Style Sliding

Music Rest Yes (with music braces)

Voices

Tone Generator

Piano Sound Yamaha CFX, Bösendorfer Imperial

Binaural Sampling Yes (“CFX Grand” and “Bösendorfer” only)

VRM (Virtual 
Resonance Modeling)

Yes

Grand Expression 
Modeling

Yes

Polyphony (max.) 256

Preset Number of Voices
53 Voices + 480 XG Voices + 

14 Drum/SFX Kits
38 Voices

Compatibility
XG (GM), GS (for Song playback),

 GM2 (for Song playback)
–

Effects

Types

Reverb 7 types

Chorus 3 types

Brilliance 7 types + User

Insertion Effect 12 types

Intelligent Acoustic 
Control (IAC)

Yes

Stereophonic 
Optimizer

Yes

Functions

Dual Yes

Split Yes

Duo Yes

Songs

Preset
Number of Preset 
Songs

27 Voice Demo + 50 Classics + 
303 Lesson Songs

23 Voice Demo + 50 Classics + 
303 Lesson Songs

MIDI Recording

Number of Songs 250

Number of Tracks 16

Data Capacity Approx. 500 KB/Song (approx. 22,000 notes)
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The contents of this manual apply to the latest specifications as of the publishing date. To obtain the latest manual, access the Yamaha website then 
download the manual file. Since specifications, equipment or separately sold accessories may not be the same in every locale, please check with your 
Yamaha dealer.

Songs

Audio Recording 
(USB flash drive) 

Recording Time (max.) 80 minutes/Song

Compatible Data 
Format

Playback SMF (Format 0, Format 1), WAV (44.1 kHz, 16-bit, stereo)

Recording  SMF (Format 0), WAV (44.1 kHz, 16-bit, stereo)

Functions

Piano Room Yes

Rhythm Number of Rhythms 20

Overall Controls

Metronome Yes

Tempo Range 5 – 500

Transpose −12 – 0 – +12

Tuning 414.8 – 440.0 – 466.8 Hz (approx. 0.2 Hz increments)

Scale Type 7 types

USB Audio Interface 44.1 kHz, 24-bit, stereo

Bluetooth
(May not have 
this functionality 
depending on 
the country in 
which you 
purchased the 
product.)

Audio Supported profile: A2DP, Compatible codec: SBC

MIDI Comply with Bluetooth Low Energy MIDI Specification

Bluetooth version 5.0 

Wireless output Bluetooth Class 2

Maximum 
communication 
distance

Approx. 10 m

Radio Frequency 2,401 – 2,481 MHz

Maximum output power 
(EIRP)

4 dBm

Type of modulation GFSK

Storage and 
Connectivity

Storage
Internal Memory Approx. 1.4 MB

External Drives  USB flash drive

Connectivity

Headphones Standard stereo phone jack (× 2)

AUX IN Stereo mini jack

AUX OUT Standard phone jack (L/L+R, R)

USB TO DEVICE Type A

USB TO HOST Type B

DC IN 24 V

Amplifiers 
and Speakers

Amplifiers (45 W + 45 W + 45 W) × 2 (45 W + 35 W) × 2

Speakers
(16 cm + 8 cm with Waveguide + 2.5 cm 

(dome) with Waveguide) × 2, 
Spruce Cone Speaker

(16 cm with diffuser + 5 cm) × 2

Power 
Supply

AC Adaptor PA-500

Output DC 24 V, 2.5 A

Polarity

Power Consumption
60 W

(When using PA-500 AC adaptor)
55 W

(When using PA-500 AC adaptor)

Included Accessories

• Owner’s Manual
• “50 Classical Music Masterpieces” Music Book
• Online Member Product Registration
• Bench*
• Power cord*, AC adaptor*: PA-500

*May not be included depending on your area. Check with your Yamaha dealer.

Separately Sold Accessories
(May not be available depending on your area.)

• Headphones: HPH-150, HPH-100, HPH-50
• Pedal unit: FC35
• AC adaptor: PA-500 
• USB wireless LAN adaptor: UD-WL01

CLP-895GP CLP-865GP
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A
A-B Repeat ....................................34

App ................................................46

Assembly .......................................63

Audio Loopback .............................49

Audio Recording ............................37

Audio Song ....................................30

Auto Power Off ..............................17

[AUX IN] jack .................................45

B
Bluetooth .......................7, 21, 43, 46

Body Resonance ...........................24

Brightness .....................................24

C
Computer .......................................48

Control panel .................................20

D
Damper Noise ...............................24

Damper Resonance ......................24

Data List ........................................10

Delete ............................................42

Demo .......................................31, 55

Dual ...............................................27

Duo ................................................28

Duplex Scale Resonance ..............24

F
Factory Reset ................................22

Fast forward ..................................32

Format (USB flash drive) ...............49

G
Grand Expression Modeling ..........24

H
Half pedal ......................................25

Headphones ..................................18

I
Initialize (Factory Reset) ................22

Input ..............................................43

K
Key cover ......................................14

L
Lid ............................................15, 24

M
Master Tune ................................. 24

Menu ............................................. 51

Message List ................................ 58

Metronome ................................... 25

Metronome/Rhythm menu ............ 51

MIDI Recording ............................. 37

MIDI Song ..................................... 30

Multi track recording ..................... 41

Music rest ..................................... 15

O
Output ........................................... 50

Overdubbing ................................. 41

P
Pairing .......................................... 44

Part (playback) ............................. 35

Part (recording) ....................... 40, 41

Pedal ............................................ 19

Piano Room .................................. 23

Pitch .............................................. 24

Playback (Rhythm) ....................... 29

Playback (Song) ........................... 30

Power ..................................... 16, 17

R
Recording ..................................... 37

Recording menu ........................... 51

Reference Manual ........................ 10

Repeat playback ........................... 33

Reset ............................................ 22

Reverb .......................................... 24

Rewind .......................................... 32

Rhythm ......................................... 29

Rhythm List ................................... 56

S
Smart device ................................. 46

Smart Pianist ................................ 46

Smart Pianist User Guide ............. 10

Song ............................................. 30

Song List ....................................... 57

Song menu ................................... 51

Speed ........................................... 33

Split ............................................... 27

Split Point ..................................... 28

String Resonance ......................... 24

System menu ................................ 51

T
Tempo ............................... 25, 29, 33

Touch ............................................ 24

Track (playback) ........................... 35

Track (recording) ..................... 40, 41

Transpose ..................................... 36

Troubleshooting ............................ 61

Tuning ........................................... 24

U
USB Audio Interface ..................... 48

USB flash drive ............................. 49

USB [TO DEVICE] terminal .......... 47

USB [TO HOST] terminal ........ 45, 47

V
Voice ............................................. 26

Voice Demo ............................ 31, 55

Voice List ...................................... 52

Voice menu ................................... 51

Volume .......................................... 18

VRM (Virtual Resonance Modeling) 
....................................................... 24

W
Wi-Fi .............................................. 47

Wireless LAN ................................ 47

X
XG Voices (CLP-885/CLP-895GP 
only) .............................................. 26

Index
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For U.S.A.

For Canada

This transmitter must not be co-located or operated in conjunction with any other antenna or transmitter.

(554-M01 FCC transmitter 01)

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment and meets the 
FCC radio frequency (RF) Exposure Guidelines. This equipment has very low levels of RF energy that is deemed to 
comply without testing of specific absorption rate (SAR).

(554-M04 FCC portable 01)

Important Notice:
U.S. LIMITED WARRANTY for Customers in the United States

For detailed information about this Yamaha product and warranty service, please either visit the following 
website address (printable file is available at our website) or contact Customer Service at the address or 

telephone number identified below.

Website Address:
Yamaha.io/ClavinovaWarranty

Customer Service:
Yamaha Corporation of America

6600 Orangethorpe Avenue, Buena Park, CA 90620
Telephone: 800-854-1569

This equipment complies with ISED radiation exposure limits set forth for an uncontrolled environment and meets 
RSS-102 of the ISED radio frequency (RF) Exposure rules as this equipment has very low levels of RF energy.

Cet équipement est conforme aux limites d’exposition aux rayonnements énoncées pour un environnement non 
contrôlé et respecte les règles d’exposition aux fréquences radioélectriques (RF) CNR-102 de l’ISDE puisque cet 
appareil a une niveau tres bas d’energie RF.

(0555-M05_ised_portable_01)

This device contains licence-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and Economic 
Development Canada’s licence-exempt RSS(s). Operation is subject to the following two conditions:
1. This device may not cause interference.
2. This device must accept any interference, including interference that may cause undesired operation of the device.

L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR d’Innovation, 
Sciences et Développement économique Canada applicables aux appareils radio exempts de licence. L’exploitation 
est autorisée aux deux conditions suivantes :
1. L’appareil ne doit pas produire de brouillage ;
2. L’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en 
compromettre le fonctionnement.

(555-M13 ISED RSS 01)
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For United Kingdom

SIMPLIFIED UK DECLARATION OF CONFORMITY
Hereby, Yamaha Corporation declares that the [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] is 
in compliance with the Product Security and Telecommunications Infrastructure Regulations. The full text of the UK 
declaration of conformity is available at the following internet address:
https://europe.yamaha.com/en/support/compliance/doc.html

https://europe.yamaha.com/en/support/compliance/doc.html
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For European Union and United Kingdom

(559-M01 RED DoC URL 03)

EN SIMPLIFIED EU DECLARATION OF CONFORMITY / 
SIMPLIFIED UK DECLARATION OF CONFORMITY

Hereby, Yamaha Corporation declares that the radio equipment type [CLP-
885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] is in 
compliance with Directive 2014/53/EU and the radio equipment regulations 
of UK. The full texts of the EU declaration of conformity and the UK 
declaration of conformity are available at the following internet address:
https://europe.yamaha.com/en/support/compliance/doc.html

FR DECLARATION UE DE CONFORMITE SIMPLIFIEE
Le soussigné, Yamaha Corporation, déclare que l'équipement radioélectrique du 
type [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] est 
conforme à la directive 2014/53/UE. Le texte complet de la déclaration UE de 
conformité est disponible à l'adresse internet suivante :
https://europe.yamaha.com/en/support/compliance/doc.html

DE VEREINFACHTE EU-KONFORMITÄTSERKLÄRUNG
Hiermit erklärt Yamaha Corporation, dass der Funkanlagentyp [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] der Richtlinie 2014/
53/EU entspricht. Der vollständige Text der EU-Konformitätserklärung ist 
unter der folgenden Internetadresse verfügbar:
https://europe.yamaha.com/en/support/compliance/doc.html

SV FÖRENKLAD EU-FÖRSÄKRAN OM ÖVERENSSTÄMMELSE
Härmed försäkrar Yamaha Corporation att denna typ av radioutrustning 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] 
överensstämmer med direktiv 2014/53/EU. Den fullständiga texten till EU-
försäkran om överensstämmelse finns på följande webbadress:
https://europe.yamaha.com/en/support/compliance/doc.html

IT DICHIARAZIONE DI CONFORMITÀ UE SEMPLIFICATA
Il fabbricante, Yamaha Corporation, dichiara che il tipo di apparecchiatura 
radio [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] è 
conforme alla direttiva 2014/53/UE. Il testo completo della dichiarazione di 
conformità UE è disponibile al seguente indirizzo Internet:
https://europe.yamaha.com/en/support/compliance/doc.html

ES DECLARACIÓN UE DE CONFORMIDAD SIMPLIFICADA
Por la presente, Yamaha Corporation declara que el tipo de equipo 
radioeléctrico [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-
865GP] es conforme con la Directiva 2014/53/UE. El texto completo de la 
declaración UE de conformidad está disponible en la dirección Internet 
siguiente:
https://europe.yamaha.com/en/support/compliance/doc.html

PT DECLARAÇÃO UE DE CONFORMIDADE SIMPLIFICADA
O(a) abaixo assinado(a) Yamaha Corporation declara que o presente tipo 
de equipamento de rádio [CLP-885, CLP-875, CLP-845, CLP-835, CLP-
-895GP, CLP-865GP] está em conformidade com a Diretiva 2014/53/UE. O 
texto integral da declaração de conformidade está disponível no seguinte 
endereço de Internet:
https://europe.yamaha.com/en/support/compliance/doc.html

NL VEREENVOUDIGDE EU-CONFORMITEITSVERKLARING
Hierbij verklaar ik, Yamaha Corporation, dat het type radioapparatuur [CLP-
885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] conform is 
met Richtlijn 2014/53/EU. De volledige tekst van de EU-
conformiteitsverklaring kan worden geraadpleegd op het volgende 
internetadres:
https://europe.yamaha.com/en/support/compliance/doc.html

BG ОПРОСТЕНА ЕС ДЕКЛАРАЦИЯ ЗА СЪОТВЕТСТВИЕ
С настоящото Yamaha Corporation декларира, че този тип 
радиосъоръжение [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, 
CLP-865GP] е в съответствие с Директива 2014/53/ЕС. Цялостният 
текст на ЕС декларацията за съответствие може да се намери на 
следния интернет адрес:
https://europe.yamaha.com/en/support/compliance/doc.html

CS ZJEDNODUŠENÉ EU PROHLÁŠENÍ O SHODĚ
Tímto Yamaha Corporation prohlašuje, že typ rádiového zařízení [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] je v souladu se 
směrnicí 2014/53/EU. Úplné znění EU prohlášení o shodě je k dispozici na 
této internetové adrese:
https://europe.yamaha.com/en/support/compliance/doc.html

DA FORENKLET EU-OVERENSSTEMMELSESERKLÆRING
Hermed erklærer Yamaha Corporation, at radioudstyrstypen [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] er i 
overensstemmelse med direktiv 2014/53/EU. EU-
overensstemmelseserklæringens fulde tekst kan findes på følgende 
internetadresse:
https://europe.yamaha.com/en/support/compliance/doc.html

ET LIHTSUSTATUD ELI VASTAVUSDEKLARATSIOON
Käesolevaga deklareerib Yamaha Corporation, et käesolev raadioseadme 
tüüp [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] 
vastab direktiivi 2014/53/EL nõuetele. ELi vastavusdeklaratsiooni täielik 
tekst on kättesaadav järgmisel internetiaadressil:
https://europe.yamaha.com/en/support/compliance/doc.html

EL ΑΠΛΟΥΣΤΕΥΜΕΝΗ ΔΗΛΩΣΗ ΣΥΜΜΟΡΦΩΣΗΣ ΕΕ
Με την παρούσα ο/η Yamaha Corporation, δηλώνει ότι ο ραδιοεξοπλισμός 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] πληροί 
την οδηγία 2014/53/ΕΕ. Το πλήρες κείμενο της δήλωσης συμμόρφωσης ΕΕ 
διατίθεται στην ακόλουθη ιστοσελίδα στο διαδίκτυο:
https://europe.yamaha.com/en/support/compliance/doc.html

HR POJEDNOSTAVLJENA EU IZJAVA O SUKLADNOSTI
Yamaha Corporation ovime izjavljuje da je radijska oprema tipa [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] u skladu s 
Direktivom 2014/53/EU. Cjeloviti tekst EU izjave o sukladnosti dostupan je 
na sljedećoj internetskoj adresi:
https://europe.yamaha.com/en/support/compliance/doc.html

LV VIENKĀRŠOTA ES ATBILSTĪBAS DEKLARĀCIJA
Ar šo Yamaha Corporation deklarē, ka radioiekārta [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP] atbilst Direktīvai 2014/53/ES. 
Pilns ES atbilstības deklarācijas teksts ir pieejams šādā interneta vietnē:
https://europe.yamaha.com/en/support/compliance/doc.html

LT SUPAPRASTINTA ES ATITIKTIES DEKLARACIJA
Aš, Yamaha Corporation, patvirtinu, kad radijo įrenginių tipas [CLP-885, CLP-
875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] atitinka Direktyvą 2014/53/
ES. Visas ES atitikties deklaracijos tekstas prieinamas šiuo interneto adresu:
https://europe.yamaha.com/en/support/compliance/doc.html

HU EGYSZERŰSÍTETT EU-MEGFELELŐSÉGI NYILATKOZAT
Yamaha Corporation igazolja, hogy a [CLP-885, CLP-875, CLP-845, CLP-
835, CLP-895GP, CLP-865GP] típusú rádióberendezés megfelel a 2014/53/
EU irányelvnek. Az EU-megfelelőségi nyilatkozat teljes szövege elérhető a 
következő internetes címen:
https://europe.yamaha.com/en/support/compliance/doc.html

PL UPROSZCZONA DEKLARACJA ZGODNOŚCI UE
Yamaha Corporation niniejszym oświadcza, że typ urządzenia radiowego 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] jest 
zgodny z dyrektywą 2014/53/UE. Pełny tekst deklaracji zgodności UE jest 
dostępny pod następującym adresem internetowym:
https://europe.yamaha.com/en/support/compliance/doc.html

RO DECLARAȚIA UE DE CONFORMITATE SIMPLIFICATĂ
Prin prezenta, Yamaha Corporation declară că tipul de echipamente radio 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] este în 
conformitate cu Directiva 2014/53/UE. Textul integral al declarației UE de 
conformitate este disponibil la următoarea adresă internet:
https://europe.yamaha.com/en/support/compliance/doc.html

SK ZJEDNODUŠENÉ EÚ VYHLÁSENIE O ZHODE
Yamaha Corporation týmto vyhlasuje, že rádiové zariadenie typu [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] je v súlade so 
smernicou 2014/53/EÚ. Úplné EÚ vyhlásenie o zhode je k dispozícii na tejto 
internetovej adrese:
https://europe.yamaha.com/en/support/compliance/doc.html

SL POENOSTAVLJENA IZJAVA EU O SKLADNOSTI
Yamaha Corporation potrjuje, da je tip radijske opreme [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP] skladen z Direktivo 2014/53/
EU. Celotno besedilo izjave EU o skladnosti je na voljo na naslednjem 
spletnem naslovu:
https://europe.yamaha.com/en/support/compliance/doc.html

FI YKSINKERTAISTETTU EU-VAATIMUSTENMUKAISUUSVAKUUTUS
Yamaha Corporation vakuuttaa, että radiolaitetyyppi [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP] on direktiivin 2014/53/EU 
mukainen. EU-vaatimustenmukaisuusvakuutuksen täysimittainen teksti on 
saatavilla seuraavassa internetosoitteessa:
https://europe.yamaha.com/en/support/compliance/doc.html

TR BASİTLEŞTİRİLMİŞ AVRUPA BİRLİĞİ UYGUNLUK BİLDİRİMİ
İşbu belge ile, Yamaha Corporation, radyo cihaz tipinin [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP], Direktif 2014/53/ AB'ye 
uygunluğunu beyan eder. AB uyumu beyanının tam metni aşağıdaki internet 
adresinden edinilebilir:
https://europe.yamaha.com/en/support/compliance/doc.html
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Yamaha Worldwide Representative Offices

For details on the product(s), contact your nearest Yamaha representative or the authorized distributor, 
found by accessing the 2D barcode below.

English

Wenden Sie sich für nähere Informationen zu Produkten an eine Yamaha-Vertretung oder einen 
autorisierten Händler in Ihrer Nähe. Diese finden Sie mithilfe des unten abgebildeten 2D-Strichodes.

Deutsch

Pour obtenir des informations sur le ou les produits, contactez votre représentant ou revendeur agréé 
Yamaha le plus proche. Vous le trouverez à l'aide du code-barres 2D ci-dessous.

Français

Para ver información detallada sobre el producto, contacte con su representante o distribuidor autorizado 
Yamaha más cercano. Lo encontrará escaneando el siguiente código de barras 2D.

Español

Per dettagli sui prodotti, contattare il rappresentante Yamaha o il distributore autorizzato più vicino, che è 
possibile trovare tramite il codice a barre 2D in basso.

Italiano

Para mais informações sobre o(s) produto(s), fale com seu representante da Yamaha mais próximo ou com 
o distribuidor autorizado acessando o código de barras 2D abaixo.

Português

https://manual.yamaha.com/dmi/address_list/

Head Office/Manufacturer: Yamaha Corporation 10-1, Nakazawa-cho, Chuo-ku, Hamamatsu, 430-8650, Japan
Importer (European Union): Yamaha Music Europe GmbH Siemensstrasse 22-34, 25462 Rellingen, Germany
Importer (United Kingdom): Yamaha Music Europe GmbH (UK) Sherbourne Drive, Tilbrook, Milton Keynes, MK7 8BL, United Kingdom

DMI35



Yamaha Global Site
https://www.yamaha.com/

Yamaha Downloads
https://download.yamaha.com/

© 2024 Yamaha Corporation
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